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Universal Type Server
Management
What’s new
Universal Type Client 7.0.10

n We have added an auto-activation plug-in for Adobe After Effects CC 2021.

Universal Type Client 7.0.9
n We have validated Universal Type Client for macOS 11.x and Apple M1 systems.

(Universal Type Client runs on Apple M1 systems using Rosetta 2 emulation.)

Universal Type Client 7.0.7
n Auto-activation plug-ins for Adobe Creative Cloud 2021 releases of Illustrator, InCopy, InDesign,

and Photoshop.
n Extensis Font Panel for Adobe CC 2021 releases of Illustrator, InDesign, and Photoshop.

Version 7.0.6
n Type Server: Support for PostgreSQL as an external database.
n Type Client: We added a confirmation dialog when deleting a user-created font attribute.

IMPORTANT: Support for Microsoft SQL Server and MySQL has been discontinued. While we support
these external databases in the current release of Universal Type Server, they will be dropped in a
future release.

Universal Type Client 7.0.4
n Support for macOSCatalina.
n Auto-activation plug-ins for Adobe Creative Cloud 2020 releases of After Effects, Illustrator,

InCopy, InDesign, and Photoshop.
n Extensis Font Panel for Adobe CC 2020 releases of Illustrator, InDesign, and Photoshop.
n Auto-activation plug-in for Sketch.

Version 7.0.3
n The Windows Core Client now enforces the System Font Policy.
n Universal Type Client includes in-app messaging to provide important product information.
n We have added set creation and activation capability to the Adobe Fonts library.
n We have added an auto-activation plug-in for QuarkXPress 2019.

Version 7.0.2
n Universal Type Client and Core Client are now completely 64-bit.
n Universal Type Server no longer requires serial numbers for licensing the server and components;

instead, you enter the Extensis account credentials (email address and password) of the
software’s License Administrator.

n Universal Type Server includes in-app messaging to provide important product information to the
Server Administrator.
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Version 7.0.1
n Font Usage by User report: This new report provides administrators with a snapshot of a user’s

current font usage.

Version 7.0.0
The big news in Universal Type Server 7 is the completely new Management application for managing
users, workgroups, and fonts. This application uses modern Web technologies (and eliminates Adobe
Flash) to provide an experience that is easier to navigate, fast, streamlined, and secure.

This release also includes:
n Auto-activation plug-ins for Adobe CC 2019.
n Improved security between Universal Type Client and Universal Type Server.
n Bug fixes.

System requirements
For the most up-to-date information about the latest release of Universal Type Server, please visit
Universal Type Server System Requirements.

IMPORTANT: An Internet connection is required for the activation and use of Universal Type Server.
See Entering serial numbers into Universal Type Server version 7.0.2 or later.

Macintosh Server
n macOS™ 10.12 through 10.14
n 2.0 GHz or faster processor
n 4 GB RAM (8 GB recommended)
n 2 GB available hard drive space for application files, plus additional space for fonts

Windows Server
NOTE: Universal Type Server 7 requires a 64-bit version of Windows.

n Windows® Server 2012 R2, Windows Server 2016, or Windows Server 2019
n 2.0 GHz or faster multi-core processor
n 4 GB RAM (8 GB recommended)
n 2 GB available hard drive space for application files, plus additional space for fonts

Enterprise Edition database requirements
Enterprise Edition users have the option of utilizing one of these external databases. Use of an external
database is requiredwith a proxy failover configuration.

n PostgreSQL version 12.2 or 12.3 (macOS or Windows)
n (Deprecated) Microsoft SQL Server 2012 or 2016 (Windows)
n (Deprecated) MySQL 5.5, 5.6, or 5.7 (macOS or Windows)

IMPORTANT: Support for Microsoft SQL Server and MySQL is deprecated. While we support these
external databases in the current release of Universal Type Server, they will be dropped in a future
release.

Universal Type Server System Requirements: https://www.extensis.com/support/universal-type-server-
7/system-requirements

Entering serial numbers: https://help.extensis.com/hc/en-us/articles/360018517534

https://www.extensis.com/support/universal-type-server-7/system-requirements
https://help.extensis.com/hc/en-us/articles/360018517534
https://www.extensis.com/support/universal-type-server-7/system-requirements
https://www.extensis.com/support/universal-type-server-7/system-requirements
https://help.extensis.com/hc/en-us/articles/360018517534
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Macintosh Universal Type Client
n macOS 10.11 through 10.15 and macOS 11
n 2.0 GHz or faster Intel processor

(Universal Type Client runs on Apple M1 systems using Rosetta 2 emulation.)
n 1 GB available hard drive space for application files, plus additional space for fonts
n 100 Mbit/s or faster network connection
n An Internet connection and Safari® 9 or later or the current release of Firefox® or Chrome™ to

view Help

Windows Universal Type Client
n Windows 7, Windows 8.1, or Windows 10

(64-bit only)
n 2.0 GHz or faster processor
n 1 GB available hard drive space for application files, plus additional space for fonts
n 100 Mbit/s or faster network connection
n An Internet connection and Internet Explorer® 11, Microsoft Edge, or the current release of Firefox

or Chrome to view Help

Server Administration and User Management
Requirements for any computers that will be used for Server Administration or User Management. These
applications can be run remotely.

n Microsoft Edge (for administering the server fromWindows), Safari 11 or later (for administering
the server from a Macintosh), or the current release of Firefox or Chrome.

n An Internet connection and one of the above browsers to view Help.

Reports
Reports can be viewed from any supported desktop browser.

n Microsoft Edge (for viewing reports fromWindows 10), or
n Safari 11 or later (for viewing reports frommacOS), or
n The current release of Firefox, or
n The current release of Chrome.

Reports can also be viewed from a tablet on the same network as the Universal Type Server. Minimum
requirements are:

n iOS 11 or later, Android™ 9.0 or later, or Windows 10 version 1803 or later, and
n 1024×768 or larger display.
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Opening User Management
Administrators manage users, workgroups, roles, and permissions using the User Management
application. This application can be accessed through any supported web browser.

To open the User Management application:
n Open a supported web browser.
n In the address bar, enter your Type Server’s IP address followed by a colon and the port number.

The default User Management port is 8080.
Example: http://10.1.2.32:8080 or http://localhost:8080 if administering the server locally.

n Choose a display language from the menu.
n Enter a user name and password and click Login.

Passwords are case-sensitive but user names are not.

You can also start the User Management application from the Universal Type Client; choose Server >
Manage Users and Workgroups.

NOTE: If you log in using the Server Administrator account, for the most secure configuration, change
the password as soon after installation as possible. SeeChanging the Server Administrator
password on page 14.

Changing the display language
Change the display language from the drop-down menu on the User Management login page.

The application supports administration in English, German, Spanish, and French.

It’s important to note that this only changes the language displayed in the User Management page. The
client’s user interface, as well as the Server Administration application remain in the language currently
selected for each application.

SSL security
The Universal Type Server User Management application includes a secure connection option through
port 8443. See the Server Administration User Guide or help system for details about implementing your
own security certificate.
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Tour

A. Workspace list
Click a label in the list to open that workspace.

B. Account menu
Click the menu to choose additional setup options, view Help, or log out.

C. Work list
Select a specific item to view or modify. The contents of this list depend on the workspace.

D. Work area
Edit information for the selection in the work list

The Management application is organized into a series of functional workspaces. Choose a workspace
from the list along the top of the window.

The workspaces available will depend on the permissions for your account.

Administration: Use the Administration workspace to add and remove licenses. In Universal Type Server
7.0.2 and later, a license does not require a serial number; you validate your licenses and features
through a one-time connection to an Extensis server. See Licensing Universal Type Server on page 11
for details about licensing.

Fonts: Shows the fonts available to Universal Type Server. The work list can be filtered by license,
connected user, workgroup, or compliance status; the work area shows the fonts associated with the
selection of items in the work list. (Fonts are installed using the Universal Type Client.)

Users: The work list allows you to filter the displayed users by a specific workgroup (or all workgroups),
then the work area shows account information for a selected user. You can add and remove native user
accounts, assign users to workgroups, and change a user’s settings and permissions.

Workgroups: A workgroup is a collection of users with access to the same set of fonts. You can created,
edit, and delete workgroups. Choose a workgroup from the work list to see and filter its members.

User Roles: A user role is a pre-defined set of permissions. Apply a role to a user to quickly grant them
those permissions. Since a user might have different responsibilities in different workgroups, each user
can have a different role for each workgroup. There are four default roles, and you can add your own.
(Each user can also have custom permissions.)

Font Licenses: In Universal Type Server, a Font License is used tomeasure and optionally restrict usage
for each font. In the work list, you can add, edit, and remove licenses, and edit the Terms of Use that can
be applied to font licenses. In the work area you can edit details for each license, and attach electronic
documentation of the license and purchase.
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Reports: Universal Type Server provides a variety of graphical reports that show details about fonts,
users, workgroups, and font usage. The data for a report can be exported to a spreadsheet-compatible
format.

Quick start
After installing Universal Type Server and performing any necessary configuration in the Server
Administration application, the next step in the installation process is to plan your configuration, then
create workgroups and add users.

Workgroups are the containers in which fonts are stored. Administrators provide user access to fonts by
adding users to workgroups. All workgroup and user tasks are performed through the User Management
application. It is here that administrators create workgroups and user accounts as well as manage
associated settings and permissions.

The basic user and workgroup configuration steps include:
n Plan your configuration (seeConfiguration scenarios on page 19)
n Create workgroups (seeCreating and editing workgroups on page 32)
n Create new users (seeCreating and editing users on page 35)
n Add users to workgroups (see Adding users to workgroups on page 40)
n Assign workgroup roles to users (see Applying a role on page 40)
n Modify user settings as required (see Settings on page 36)

After completing the steps above, you are ready to add fonts to workgroups using the Universal Type
Client.

Most font-related tasks—such as adding and deleting fonts, tagging fonts with keywords, and font
activation—are accomplished using the Type Client. For detailed instructions, see the Universal Type
Client User Guide and help system.
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Setup
The Management application is installed as part of the Universal Type Server package.

To start the Management application, open your web browser and enter the IP address of your Type
Server, followed by a colon and the port number for the Management app (by default, this is 8080).

For example, if your Type Server’s IP address is 123.45.67.89, then youwould enter 123.45.67.89:8080.

At the login page, choose a display language, then enter your login credentials.

The first thing youwill need to do after installing Universal Type Server is activate your license.

Licensing Universal Type Server
Trial version
You can use all Universal Type Server features on a trial basis; request a trial from Extensis. Youwill
receive a trial license by email.

To license the trial version:
1. Start the Management application and log in.
2. Click the Administration tab, then click Licenses.
3. Click Try Universal Type Server.
4. Enter the trial license and click Submit.

Youmay receive multiple trial licenses to allow you to review multiple features, such as FontLink Module
for InDesign Server; you can enter each license separately or paste them all into the Trial License
dialog.

Full license
IMPORTANT: An Internet connection is required for the activation and use of Universal Type Server.
See Entering serial numbers into Universal Type Server version 7.0.2 or later.

In previous releases of Universal Type Server, youwould enter one or more serial numbers that identified
various features that would be activated.

In order to activate your current installation, you just need to enter an email address and password one
time.
1. Start the Management application and log in.
2. Click the Administration tab, then click Licenses.
3. Click Activate Universal Type Server.
4. In the Login dialog, enter the email and password of your License Administrator and click Submit.

(For more information, see The License Administrator on the next page.)

Your Type Server will communicate with Extensis to determine your license information and activate your
installation.

Request a Demo: https://www.extensis.com/request-a-demo-universal-type-server
Entering serial numbers: https://help.extensis.com/hc/en-us/articles/360018517534

https://www.extensis.com/request-a-demo-universal-type-server
https://help.extensis.com/hc/en-us/articles/360018517534
https://www.extensis.com/request-a-demo-universal-type-server
https://help.extensis.com/hc/en-us/articles/360018517534
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If your organization has multiple licenses for Universal Type Server with the same License Administrator
account, youwill be presented with a list of possible licenses; choose the appropriate one from the list
and click Select.

INSTALLATION NOTES
n If this is a new installation of Universal Type Server, youwill need to activate your license

using the above process.
n If you have upgraded from Universal Type Server 6.x, youwill need to activate your new

license using the above process.
n When upgrading from Universal Type Server 7.0 or 7.0.1, you can continue to use your

existing license. To add new features, youwill need to remove your existing license, then
activate your new license using the above process (which requires an Internet connection). See
Adding features on the next page.

The License Administrator
For new licenses, the License Administrator is the person designated as your organization’s contact
when the order for Universal Type Server is placed with Extensis or an authorized reseller.

For upgrades, the License Administrator is the person who registered your current license.

If you need to find or change your License Administrator, please use the Support Form and enter this
information:

n Your email address
n Subject: Enter “Type Server License Administrator”
n Description: Please identify whether you need to find who your License Administrator is, or to

change your License Administrator. Be sure to include the name and email address of the new
License Administrator.

n Support Type:Choose “Account Issue”

NOTE: If you are running a licensed copy of Universal Type Server 7.0.2 or later, the email address
used for the License Administrator is shown at the top of the Licenses panel in the Administration
tab. If this information is not sufficient for you to identify a person in your organization, then use the
Support Form to contact us.

Deactivating Universal Type Server
If you need to remove the license from your installation of Universal Type Server (for instance, if you need
tomove it to another system):
1. Open the Management application.
2. Click the Administration tab, then click Licenses.
3. Click Remove, then click OK in the confirmation dialog.

Support Form: https://help.extensis.com/hc/en-us/requests/new/

https://help.extensis.com/hc/en-us/requests/new/
https://help.extensis.com/hc/en-us/requests/new/
https://help.extensis.com/hc/en-us/requests/new/
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Adding features
You can license new features for Universal Type Server, such as additional client seats, Core Client
access, or FontLink for InDesign Server.

Some new features will appear automatically (an Enterprise license upgrade or FontLink for InDesign
Server); check the Administration tab of the Management application to see that these are present. (If
these additions do not show up soon, you can use the following process tomanually update your
licenses.)

If you have added more Type Client or Core Client seats, then youwill need to update your licenses:
1. Open the Management application.
2. Click the Administration tab, then click Licenses.
3. Click Remove, then click OK.
4. Click Activate Universal Type Server.
5. Enter the credentials for your License Administrator account, then click Submit.

If you have multiple Type Server licenses with the same License Administrator, choose the
appropriate license and click Select.

Additional steps
Review these additional setup operations:

n Changing the Server Administrator password on the next page
n New user defaults on the next page
n Importing users on page 15
n Active Directory on page 45
n System Font Policy on page 16
n Custom roles on page 30
n Font licenses on page 54
n Terms of Use on page 55

The Administrator account
There is only one Server Administrator account per Universal Type Server installation. The Server
Administrator can perform any administrative task from the Server Administration and User
Management applications as well as any task in the Universal Type Client.

Most importantly, the Server Administrator is the only user account that is able to assign or remove the Is
Full Administrator setting (see The Full Administrator setting on page 41), and cannot be deleted
from the server.

Typically, the only time youwould use the Server Administrator account is during the initial configuration
of the Type Server, and when you need to add or remove users with the Is Full Administrator setting.

The Server Administrator username is always set to administrator and the default password for the
account is password. For optimal security, change this password as soon as possible after installation.



- 14 -

Changing the Server Administrator password
After installing the server, for security reasons, it is very important to change the password for the
Server Administrator account. This account has access to all of the functions of the Universal Type Server
and can delete and change all users and workgroups. It is important to keep this account login secure.

Until other users are created, the Server Administrator account is the only account with access to the
User Management application.

To change the administrator password:
1. Open the User Management application (seeOpening User Management on page 8).

The Server Administrator account username is administrator, and the default password for this
account is password.

2. Click Users in the workspace list at the top of the window.
3. Select the Administrator user account.
4. In the User Account Data panel, click Account.
5. Enter a new password in the Password field, then enter it again in theConfirm Password field.
6. Click Save.

IMPORTANT: Do not lose the Server Administrator password! This is the only username and
password that cannot be reset or recovered. If you do lose your Server Administrator password,
please contact Extensis technical support for assistance. See Support on page 62 for contact
information.

New user defaults
These are the default settings that will be applied when you create a new user account. These settings
can be individually changed for each user.

Defaults can be specified by the Server Administrator or a Full Administrator.

To specify default new user settings, click the Accountmenu at the top right of theManagement
window and choose New User Defaults, make whatever changes you need, then click Save.

Any User accounts you create after this point will have these settings.

For details on the effects of these settings, see Settings on page 36.

Change Password: This setting determines whether a user will be allowed to change their account
password. (This only applies to native user accounts, not Active Directory accounts.)

Activate Fonts Across Workgroups: By default, auto-activation plug-ins only activate fonts in a single
workgroup. This setting allows a plug-in to activate fonts in multiple workgroups.

Manage a Personal Workgroup: Enabling this will allow a user to have a collection of their own fonts
available, either on the server or locally on their computer.

Enforce System Font Policy: The System Font Policy determines what fonts can be installed locally on
a user’s computer, and what will be done with any fonts not included in the policy.

Disable Startup Sets: A startup set contains fonts that are automatically activated when a user logs in.
This setting allows you to disable that feature for specific users.

Time Between Server Syncs: Universal Type Client checks with the server regularly to determine
whether fonts are available to be activated. This setting determines how frequently the client checks in.

Font Replication Mode: This setting determines when fonts are downloaded from the server to a user’s
computer.
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Importing users
A fast way to create multiple user accounts at one time is to import a list of users from a tab-delimited
text (.TXT) file. This way administrators can quickly set up users before adding them to workgroups.

NOTE: Only the Server Administrator or a Full Administrator can import a list of users.

The text file must be formatted to include tab-delimited information, in order, with line breaks between
users. To import properly, the .TXT file must be saved as ASCII text with UTF-8 encoding.

The only required fields are User account name and Password. All other fields may be left blank if
desired.

n User account name
n Password
n User full name
n Email address
n Notes
n Role
n Workgroup1

...
n WorkgroupN

For example:

jsmith → johnspassword → Smith, John → jsmith@domain.com → MyNotesHere → Contractor →
Designers¶

where → represents the tab character and ¶ represents a line break.

To skip a field, but enter other information, put extra tabs between the fields. For example, to enter a
User account name, Password, and Email address only:

jsmith → johnspassword → → jsmith@domain.com¶

Multiple workgroups can be assigned by adding them at the end of each line, before the line break. For
example, an entry with twoworkgroups named Design and Production would look like this:

jsmith → johnspassword → Smith, John→ jsmith@domain.com → → Font Administrator→
Design → Production¶

In the example above, John Smith would be added to both the Design and Production workgroups and
given the Font Administrator role in both workgroups.

NOTE: Tomake it easy to create a properly formatted .TXT file, use the Export feature from your
spreadsheet program, such as Microsoft Excel.

To import a list of users:
1. Log in to the Management application as the Server Administrator, or use an account with the

Full Administrator permission.
2. Click the Accountmenu and choose Import Users.
3. Click Browse, select the file to import, then click Choose (Mac) orOpen (Windows).
4. Click Import.
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System Font Policy
A computer’s operating system keeps fonts that it requires for operation in specific folders. Depending
on his computer account permissions, a user may be able to add his own fonts to these folders.

To avoid having users install unauthorized fonts on their computers, you can enable a System Font
Policy. The System Font Policy is a list of fonts that are allowed to exist in the computer’s system font
folders. If Universal Type Client “sees” a new font installed that is not on the System Font Policy list, it
will remove the font.

The default System Font Policy list includes all required system fonts for supported Windows and Mac
operating systems. It also includes a number of fonts required by certain common applications.

You can add fonts to the list, and you can remove any fonts that are not required system fonts.

Modifying the System Font Policy
Separate System Font Policy lists exist for Windows and macOS. Each list includes required system fonts
for all supported operating systems (Windows 8.1 and Windows 10; macOS 10.11–10.15). You cannot
remove any of these required fonts from the System Font Policy lists.

Each list also includes fonts required by some common applications. You can remove any of these fonts if
desired.

You can enable the System Font Policy using the default font lists, or you can modify the lists as needed
for your environment. Youmay especially want to add corporate branding fonts or fonts required by
specific applications.

IMPORTANT: In order to add a font to either System Font Policy list, youmust be able to access the
file from the computer where you are running the Management application.

To add a font to the System Font Policy:
1. Log in to the Management application as the Server Administrator.
2. Click the Accountmenu and choose System Font Policy.
3. Click Allowed macOS System Fonts or Allowed Windows System Fonts.
4. Click the Add + button below the list.
5. Select the desired font file and click Choose.

You can select multiple font files and add them at the same time.

To remove a font from a list, select its name and click the Delete button below the list.
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Enabling the System Font Policy
You can enforce the System Font Policy for any Universal Type Client user.

IMPORTANT:On Windows, User Account Control policies may interfere with the ability to enforce a
System Font Policy. Youmay need to consider UAC configuration changes in order to utilize the System
Font Policy. See your Windows documentation for more information.

To enable the System Font Policy for a user:
1. Log in to the Management application.

The Server Administrator and Full Administrator can change this setting for any users; Workgroup
Administrators and Font Administrators can change this setting for members of their workgroups.

2. Click Users in the workspace list at the top of the window.
3. Select a user in the list on the left.
4. In the User Account Data, click Settings.
5. In the Details pane, click the Settings tab.
6. Check Enforce System Font Policy, then click Save.

TIP: To quickly enable the System Font Policy for all users, select the All Users workgroup in the list on
the left, click the first user in the list, hold down the SHIFT key and click the last user, check Enforce
System Font Policy, then click Save.

To enable the System Font Policy for new users by default:
1. Log in to the Management application using the Server Administrator or a Full Administrator

account.
2. Click the Accountmenu and choose New User Defaults.
3. Check Enforce System Font Policy.
4. Click Save.

Additional setup options
There are some other elements of Universal Type Server that you can configure at any time.

Active Directory
You can connect your Universal Type Server to your organization’s Active Directory service. This allows
you tomap AD users and groups to Type Server workgroups and provide additional options for users to
log in to your Type Server.

Learn more on page 45.

Custom roles
Universal Type Client includes several default roles that you can assign to users within workgroups. You
may find that these roles are not quite what you need for your users’ workflows. In this case, you can
create and assign custom roles that grant exactly the permissions that you require.

Learn more on page 30.

Font licenses
In order tomake the most of Universal Type Server’s ability to enforce compliance with font licenses (so
that a font is never in use by more users than you have licensed seats), you need to add Font License
information.

This information can help you demonstrate compliance at any time, and can also help you determine if
you need to add more seats for particular fonts.

Learn more on page 54.
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Terms of Use
Part of a font’s license includes where and how the font can be used. For instance, a license may allow a
font to be used in print but not embedded in a PDF. You can add these details to a Font License that you
create within the Management application. You can also add custom Terms of Use that further identify
your organization’s requirements for specific fonts.

Learn more on page 55.
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Configuration scenarios
The mechanics of setting up Universal Type Server are not difficult. Adding workgroups, roles, and users
are fairly simple matters. Yet, Universal Type Server can be configured in many different ways. To best
meet the workflow needs of your organization, we recommend that you take a moment to plan how
you’ll configure your installation.

To create the ideal solution in your environment, you need to think through all the fonts you have, where
they’re from, what they’re for, who’s using them, and how they’re using them. To help with the setup,
we describe several typical workflows along with detailed explanations of their workgroups, user
permissions, and roles. Once you identify the most logical configuration for your environment, plan out
your workgroups and users before creating your system.

Youmay find that configuring a server for a small group of users helpful when determining the
appropriate workgroups, roles, permissions, and settings for your environment.

Sample configurations
While you can structure your workflow in any way youwant, you’ll probably end up working with one of
three common configurations: department based, project based, or full access.

Organizing fonts on a Department basis
If you have distinct groups of users that each require a different set of fonts, workgroups can be created
for each department or group. This configuration is typical for companies with large numbers of users,
such as magazines and book publishers.

With this configuration, fonts are added to workgroups based on each group’s specific font needs. For
example, a publishing environment might contain workgroups for design, editorial, advertising, and
production. The fonts contained in each workgroup as well as the workgroup default roles can vary
according to the user’s font needs.

For example, the editorial department would likely have a well defined and locked down set of fonts.
Users in this workgroup just need to know that they have the correct fonts, and would not likely need
much additional font organization. With the fairly restrictive Regular User role (see Default roles on
page 28) applied as the default workgroup role, the administrator can be sure that all users in the
editorial workgroup have what they need, and aren’t able tomodify fonts.

Organizing fonts on a Project basis
With a project-based organization method you create workgroups for specific projects. This
configuration is typical for companies with a medium to a large number of users, who typically work in
teams, like design firms and ad agencies.

With this configuration youmight have a workgroup for each division, client, campaign, or other project.
Type Server users are only added to workgroups to which they are required. This way each project is
contained within its own workgroup, and users can be certain that they have the fonts required for a
project.

Providing full access
This is the most basic way to set up Universal Type Server, yet works well in environments with very few
users such as small design groups and prepress shops. Basically, all fonts are added to a single
workgroup to which all users are members. Through the use of a fairly permissive default workgroup role,
each user is given the ability to perform most actions with all of the server fonts.
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This method works great in situations where there isn’t a dedicated IT administrator, and all of your
users are fairly savvy. This workflow allows all users to have full access to all of the organization’s fonts
to complete their jobs. The downside of this method is that it doesn’t scale well to fit larger workgroups,
and has an inherent lack of control over keyword vocabulary as well as lack of control over which users
can add and remove fonts.

This method can work well if you’re installing Type Server on a trial basis.

Department-based configuration
Organizations with fairly structured departments that each have specific font needs can benefit from
organizing fonts into department workgroups. This configuration is typical for companies with large
numbers of users, such as magazines and book publishers.

For example, a publishing company might have different workgroups for the editorial, layout, and
production departments. The editorial department doesn’t choose which fonts to use, yet for copy-
fitting needs, it is imperative that they have the correct fonts for the job. The layout team needs access
to all of the company’s fonts to have creative control over the design of each project. And the production
group needs access tomost of the company’s fonts as well as the ability to collect fonts for printing jobs.
Using a department based configuration, each department has its own workgroup and default role for
users. This way administrators can easily control the fonts and permissions available to each workgroup.

Choose or create default roles
First determine what workgroups youwill need, then decide on a default role for each workgroup. The
default role defines a base set of permissions for all users added to the workgroup. Universal Type
Server’s predefined roles may work well for you, but if you require different default permissions you can
create a custom role to use as your default. SeeCustom roles on page 30.

To review the permissions for the predefined roles:
1. Log in to the Management application.
2. Click User Roles in the workspace list at the top of the window.
3. In the list on the left, select each predefined role to examine the permissions settings.

Create workgroups
Create the workgroups required for your projects or clients.

To create a workgroup:
1. ClickWorkgroups in the workspace list at the top of the window.
2. In the list at the left, click +.
3. Enter aWorkgroup Name for the workgroup.
4. Choose a Default Role from the pop-up menu.
5. Click Save to add the new workgroup.
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Create users
Create users and add them to workgroups
To create a new user:
1. Click Users in the workspace list at the top of the window.
2. Select a workgroup from the pop-up menu in the list at the left. Users you create will automatically

be added to this workgroup.
To create users without adding them to a workgroup, choose All Workgroups from the pop-up
menu.

3. Click + at the top of the list.
4. In the User Account Data panel, enter the basic account information:

n User ID: Each User ID must be unique. It’s best to use an ID that is short, easy to remember and
does not include spaces or letter case variations.

n Full Name:Optional.
n Email Address:Optional.
n Password: This case-sensitive field is optional. If left blank, a password is not required for this

user to log in.
If you enter a password, enter it again in theConfirm Password field.

n Notes: Enter any notes to appropriately identify the user.
5. Click Save to add the new user.

Add users to workgroups
To assign users tomultiple workgroups:
1. Click Users in the workspace list at the top of the window.
2. Select All Workgroups from the pop-up menu in the list at the left.
3. Right-click a User ID in the list, then chooseManage Workgroup Assignment from the shortcut

menu.
4. Check the boxes for the workgroups that youwant to assign the user to, then click OK.

TIPS
n You can select multiple users, then right-click one of the selected users to assign the same

workgroups to several users at the same time.
n You can check the All Workgroups box in the Manage Workgroup Assignment dialog to check

the boxes for all workgroups. You can then uncheck some workgroups, or leave them all
checked.

Delegate roles
After adding users to workgroups, you’ll need to delegate roles for each workgroup. Each user is
assigned the default role when added to the workgroup, yet each workgroup will likely need users who
have elevated permissions within the workgroup. It is best to assign these permissions with user roles.

When working with departments, youwill need to have at least one person who is able to add, remove,
and organize fonts within the workgroup. You can assign the Font Administrator role to users who need
this ability.

If you have teams that are continually changing, and require the addition and removal of users from
projects, youmay need to consider having a Full or Workgroup Administrator for each workgroup. Full
and Workgroup Administrators are able to log in to the User Management application and manage
users. Having additional Administrators can be handy if your teams are located in different time zones
and you need tomanage workgroups in a timely fashion.
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To delegate roles:
1. In theWorkgroups pane, select the workgroup name.
2. In the Users pane, select the user that youwant to update.
3. In the Details pane, click theWorkgroups tab.
4. Select the workgroup name from the Show permissions for Workgroup drop-down menu.
5. Choose a new role for this user in the selected workgroup from the Role in Workgroup drop-

down menu.
6. Click the Save button.

Configure user settings
After adding users, you need to determine the most appropriate font replication mode, synchronization
and personal workgroup settings for each user. These settings control when fonts are brought down
from the server to the client, and how long those fonts remain on the user’s system. Typically, the
default settings will work for most users, but for certain users exceptions can be made. These are
configured on the Settings tab for each user.

n The default time between server syncs (see Time Between Server Syncs on page 38) should work
for most installations. The exception may be a user who doesn’t often need new or updated fonts.
For these users, a longer synchronization interval can be set.

n The Font Replication mode controls when fonts are copied from the server down to the client
computer. The default mode isOn-demand, which gives users fonts only when they need to
preview or activate them. TheOn-demand setting is typically the best choice for client computers
that stay in the office. For users who are working on laptops and may need to work offline
frequently, set the font replication mode toAll (see Font Replication Mode on page 38). This
ensures that all fonts in the Type Server are downloaded to the client, and always available for
use offline.

n Enable personal workgroups (seeManage a Personal Workgroup on page 37) for users who
need to add and activate fonts that they won’t need to share with the rest of the workgroup.
Server-based personal workgroups can be very helpful for users whowork on multiple computers
and need access to the same personal fonts on each computer. Otherwise, it’s a good idea to
have all users always add fonts to the main workgroup, and use sets to further organize fonts as
necessary.

Add and organize fonts
After configuring users, distribute account login settings to users. Those who have permission can now
begin adding fonts to workgroups using the Type Client.

For more information about adding, organizing, and managing fonts, see the Universal Type Client User
Guide and help system.

Project-based configuration
This configuration is typical for companies with a medium to a large number of users, who typically work
in teams, like design firms and ad agencies. If you have projects or clients that are easily separated into
groups, a project based configuration method might be best for you.

For example, an agency that assigns employees to specific clients would benefit from having a
workgroup for each client. Using this method, users who are working with a specific client are added to
the client workgroup and thus have access to all fonts necessary for that client’s projects. Further font
organization is available within each workgroup through the use of font sets. So, if you create a
workgroup for each client, you can organize fonts within each workgroup by creating a set for each
project you do for that client.



- 23 -

Create workgroups
The first step is to create the basic workgroups required for your projects or clients.
1. Open your web browser and start the User Management application.

If it is already running, chooseWindow > Users and Workgroups.
2. In theWorkgroups pane, click the + button. This opens the New Workgroup details pane.
3. Enter aWorkgroup Name for the workgroup.
4. Choose a Default Role from the drop-down menu. For project-based workgroups, it is best to

choose the Regular User default role. Less restrictive permissions can be set later for specific
users by delegating user roles for each workgroup.

5. Click the Save button to add the new workgroup.
6. Repeat this process to create all necessary workgroups.

Create users
The next step is to create all of your users and add them to the workgroups.

To create a new user:
1. In theWorkgroups pane select your new workgroup. Selecting the workgroup ensures that new

users are automatically added to this workgroup.
2. In the Users pane, click the + button.
3. In the New User details pane, in the Account tab, enter the basic account information:

n Account Name: Each user account name must be unique. It’s best to use an account name
that is short, easy to remember and does not include spaces or letter case variations.

n Full Name: Required field. For ease of alphabetization, you can enter names in a “Last Name,
First Name” format so that names can be easily sorted in the Users pane.

n Email Address:Optional field.
n Password: This case-sensitive field is optional. If left blank, a password is not required for this

user to log in.
If you enter a password, enter it again in theConfirm Password field.

n Notes: Enter any notes to appropriately identify the user.
4. Click the Save button to add the new user.
5. Repeat this process until all of your users are added.

Add users to workgroups
After adding users, users need to be assigned to each workgroup.
1. In theWorkgroups pane, select the All Users workgroup.
2. To assign users to workgroups, from the Users pane, select one or more user names and drag

them onto a workgroup name in theWorkgroups pane. Users can belong to one or more
workgroups.

Delegate roles to users
After adding users to workgroups, you’ll need to delegate roles for users in each workgroup. Roles give
users the ability to perform extra functions within a workgroup and are set on a user-by-user basis. Most
users will do fine with the default role, while others will be assigned special abilities through the use of a
different role.

When working with projects, youwill need to have at least one person who is able to add, remove and
organize fonts within the workgroup. You can assign the Font Administrator role to users in each
workgroup who need this ability.

If you have teams that are continually changing, and require the addition and removal of users from
projects, assign the Workgroup or Full Administrator setting to at least one user for each workgroup.
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Administrators are able to log in to the User Management application and manage users. Having an
additional Administrator can also be handy if your teams are located in different time zones and you
need tomanage workgroups in a timely fashion.

Before assigning roles, click each role name in the Roles pane. If these roles do not meet your needs, you
can create a custom role (seeCustom roles on page 30) to assign to users.

To delegate roles:
1. In theWorkgroups pane, select the workgroup name.
2. In the Users pane, select the user that youwant to update.
3. In the Details pane, click theWorkgroups tab.
4. Select the workgroup name from the Show permissions for Workgroup drop-down menu.
5. Choose a new role for this user in the selected workgroup from the Role in Workgroup drop-

down menu.
6. Click the Save button.

Configure user settings
After adding users, you need to determine the most appropriate font replication mode, synchronization
and personal workgroup settings for each user. These settings control when fonts are brought down
from the server to the client, and how long those fonts remain on the user’s system. Typically, the
default settings will work for most users, but for certain users exceptions can be made. These are
configured on the Settings tab for each user.

n The default time between server syncs (see Time Between Server Syncs on page 38) should work
for most installations. The exception may be a user who doesn’t often need new or updated fonts.
For these users, a longer synchronization interval can be set.

n The Font Replication mode controls when fonts are copied from the server down to the client
computer. The default mode isOn-demand, which gives users fonts only when they need to
preview or activate them. The On-demand setting is typically the best choice for client computers
that stay in the office. For users who are working on laptops and may need to work offline
frequently, set the font replication mode toAll (see Font Replication Mode on page 38). This
ensures that all fonts in the Type Server are downloaded to the client, and always available for
use offline.

n Enable personal workgroups (seeManage a Personal Workgroup on page 37) for users who
need to add and activate fonts that they won’t need to share with the rest of the workgroup.
Server-based personal workgroups can be very helpful for users whowork on multiple computers
and need access to the same personal fonts on each computer. It can also be helpful for users
whomay need to experiment with a few fonts for a project before purchasing a large number of
licenses and adding those fonts to a workgroup for other users. Otherwise, it’s a good idea to
have all users always add fonts to the main workgroup, and use sets to further organize fonts as
necessary.

Add and organize fonts
After configuring users, distribute account login settings to users. Those who have permission can now
begin adding fonts to each workgroup. Other client users are then able to activate and deactivate fonts
as required for each project with the Type Client.

For more information about adding, organizing, and managing fonts, see the Universal Type Client User
Guide and help system.
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Full Access sample configuration
The most basic way to configure Universal Type Server is to place all of your fonts into a single workgroup
and allow all of your users a very permissive level of access to those fonts. This method sacrifices some of
the administration control available in Universal Type Server for the benefits having users police their
own actions with fonts on the server.

Typically workgroups such as small design houses or prepress shops will choose this method of
configuration.

The following setup instructions contain the recommended way to setup your Type Server to allow full
access for all users. Your process may vary based on your group’s needs.

Create the workgroup
The first step is to create the workgroup that will house all of your fonts.
1. Open your web browser and start the User Management application.

If it is already open, chooseWindow > Users and Workgroups.
2. In theWorkgroups pane, click the + button. This opens the New Workgroup details pane.
3. Enter a name for the workgroup in theWorkgroup Name field. This name is displayed in the

client, and is where workgroup members will add and activate fonts.
4. Choose a role to be the assigned to new workgroup members from the Default Role drop-down

menu. Since all of your users will have the same level of access, it’s a good idea to set a default role
that isn’t very restricting. If you choose Default Role > Font Administrator, this will allow any
user to perform necessary organization and maintenance tasks using the Type Client and also
gives your users a wide variety of abilities to add, organize and tag fonts within workgroups.

5. Click the Save button to add the new workgroup.

Create users
The next step is to create all of your users and add them to the workgroup.

To create a new user:
1. In theWorkgroups pane select your new workgroup. Selecting the workgroup ensures that new

users are automatically added to this workgroup.
2. In the Users pane, click the + button.
3. In the New User details pane, in the Account tab, enter the basic account information:

n Account Name: Each user account name must be unique. It’s best to use an account name
that is short, easy to remember and does not include spaces or letter case variations.

n Full Name: Required field. For ease of alphabetization, you can enter names in a “Last Name,
First Name” format so that names can be easily sorted in the Users pane.

n Email Address:Optional field.
n Password: This case-sensitive field is optional. If left blank, a password is not required for this

user to log in.
If you enter a password, enter it again in theConfirm Password field.

n Notes: Enter any notes to appropriately identify the user.
4. Click the Save button to add the new user.
5. Repeat this process until all of your users are added.
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Configure permissions
Since the Font Administrator default role is set for your only workgroup, all users will have the permission
to perform most actions with the Type Client. Notable exceptions include the ability to access the Server
Administration and User Management applications. Typically, these functions are accessed only by an
IT professional. If you don’t have a specific IT person, youmay wish to enable a user to have Full or
Workgroup Administrator permissions.

Configure user settings
After adding users, you need to determine the most appropriate font replication mode, synchronization
and personal workgroup settings for each user. These settings control when fonts are brought down
from the server to the client, and how long those fonts remain on the user’s system. Typically, the
default settings will work for most users, but for certain users exceptions can be made. These are
configured on the Settings tab for each user.

n The default time between server syncs (see Time Between Server Syncs on page 38) should work
for most installations. The exception may be a user who doesn’t often need new or updated fonts.
For these users, a longer synchronization interval can be set.

n The Font Replication mode controls when fonts are copied from the server down to the client
computer. The default mode isOn-demand, which gives users fonts only when they need to
preview or activate them. TheOn-demand setting is typically the best choice for client computers
that stay in the office. For users who are working on laptops and may need to work offline
frequently, set the font replication mode toAll (see Font Replication Mode on page 38). This
ensures that all fonts in the Type Server are downloaded to the client, and always available for
use offline.

n Enable personal workgroups (seeManage a Personal Workgroup on page 37) for users who
need to add and activate fonts that they won’t need to share with the rest of the workgroup.
Server-based personal workgroups can be very helpful for users whowork on multiple computers
and need access to the same personal fonts on each computer. Otherwise, it’s a good idea to
have all users always add fonts to the main workgroup, and use sets to further organize fonts as
necessary.

Add and organize fonts
You can now provide users with their access infomation and have them add fonts to the workgroup.

For the best organization within your workgroup, ask users to add fonts into sets that can then be
shared with all users to keep everyone in sync.

For more information about adding, organizing, and managing fonts see the Universal Type Client User
Guide and help system.
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User roles
Roles control the permissions in the Global and Workgroup permission tabs of each user. Roles are
basically a group of permission settings that can be applied simultaneously to a user that affects their
abilities in the workgroup.

Roles are dynamic in that when you change a role setting, all users who have that role in any workgroup
are immediately affected. So, if you add or remove permissions to a role, be aware that everyone with
that role setting will obtain updated permissions. User Roles are also quite powerful because they allow
you to change the abilities of a large number of users in many workgroups at one time.

Defining a user role strategy
Roles and workgroups
Roles allow administrators to quickly set up multiple users with a standard set of permissions. Even more
efficiency is gained by applying a Default Role to a workgroup. That way, every user who is added to the
workgroup receives that default role.

When organizing workgroups, youmay want to organize fonts by what level of access that is required
for users. Using this method, you can create your workgroups and assign a custom default role for each
workgroup. This way, every user who is subsequently added to each workgroup is automatically
assigned the default role. Users become almost secondary in this configuration.

For example, if a newspaper editorial department needs a specific group of fonts, yet those fonts are
well-defined and these users won’t need to choose new fonts, you can create a fairly restrictive role
setting and set it as the default role for that workgroup. That way every user who is added to the
workgroup will be restricted to using fonts as the administrator intends.

Users, roles, and workgroups
A user’s role can vary from workgroup to workgroup. A user may have the Regular User role in one
workgroup and the Font Administrator role in another. After you add a user to a workgroup, you can
change that user’s role as needed.

If a workgroup’s default role is Regular User, and you need a user to be the Font Administrator, you can
change this in the user’s Workgroup permissions tab.

It’s also important to note that permissions set for a role can be overridden for individual users in a
workgroup. It is easy to give a user custom permissions in a workgroup without changing his role.

Roles and fonts
It’s important to note that font information is stored on a server-wide basis. So, any changes to
attributes, such as keywords and foundry information, are applied across all workgroup. So, it is
important that you choose roles and permissions for your users appropriately.

For example, a user has the Font Administrator role in one workgroup, but only the Regular User role in
another. That user can make changes to font attributes in workgroup where he is a Font Administrator.
If a font exists in both workgroups, any changes to a font that the user makes as the Font Administrator
will also appear in the other workgroup.
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Default roles
Universal Type Server contains four predefined user roles. These roles are configured with commonly
used settings, and can be used as-is or as a starting place for your own custom roles.

REMEMBER: You can override role-based settings by granting or revoking permissions on a user-by-user
basis.

Predefined roles can be modified tomeet your needs, but if you need different settings it is best to
create a custom role (seeCustom roles on page 30).

Font Administrator
The Font Administrator predefined role is configured for users who need a higher level of control over
fonts in a workgroup. Users who are required to add fonts, and perform other organizational tasks such
as assigning keywords and creating shared sets, should have the Font Administrator role.

Those with the Font Administrator role can do everything the Regular User role can do as well as:
n Add and remove fonts.
n Create and delete shared sets.
n Modify shared sets.
n Create, delete and apply keywords, styles, classifications, and foundries.
n Activate fonts across multiple workgroups.
n Modify font family groupings.

Since roles are set by workgroup, users may be members of multiple workgroups yet are assigned the
Font Administrator role in only a few workgroups.

It’s important to note that if a font information is stored on a server-wide basis. So if a font exists in
multiple workgroups, and a user has the Font Administrator role in one workgroup, any changes made to
the font as the Font Administrator will also appear in every other workgroup.

Preview-only User
The Preview-only role is similar to the regular user, except that users with this role cannot activate fonts,
and cannot collect fonts for output.

A major use for the Preview-only user would be to create a workgroup where this is the default role, add
several users to the workgroup, and include a Workgroup Administrator. The Administrator can then add
fonts to the workgroup that the other members can preview.

This type of workgroup can act as a “font store” that allows your users to see the fonts that are available
on your Type Server without having to consume a license for each font. Users can identify fonts they
would like to have access to, then request that they be added to one of their other workgroups.

Regular User
The Regular User predefined role is configured for users who are mostly interested in finding and
activating fonts. A regular user might not spend much time using the Type Client, and allow the auto-
activation plug-ins to activate and deactivate fonts as required for each document and project.

Regular users can activate and deactivate fonts in workgroups for which they are members, apply
keywords to fonts, and collect fonts for output.

The Regular User predefined role is the default role for workgroups in which a default role is not assigned.
This means that any user added to a workgroup that does not have a default role set will automatically
receive the Regular User role assigned for that workgroup.
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Workgroup Administrator
The Workgroup Administrator role allows a Server Administrator to delegate the task of managing users
in a workgroup. Workgroup Administrators have the same capabilities as Font Administrators, and can
also create new users in the context of their workgroup, add existing user accounts to their workgroup,
and remove users from their workgroup.

In addition, Workgroup Administrators using the Universal Type Client will have access to a special
workgroup that shows all fonts in all workgroups that they administer. He can delete fonts from all his
workgroups by deleting them from this workgroup, and can create non-share sets in this workgroup.

Assigning roles
There are twoways to assign user roles within a workgroup:

n Using a workgroup’s default role
n Changing the user’s workgroup permission setting

Setting a workgroup’s default role
The easiest way to assign user roles is to have the workgroup do it for you. By setting a default role for a
workgroup, that role is automatically assigned to each user subsequently added to the workgroup.

To set the default role for a workgroup:
1. Open your web browser and start the User Management application.

If it is already running, chooseWindow > Users and Workgroups.
2. In theWorkgroups pane, select the workgroup.
3. In the Details pane, choose a role from the Default Role drop-down menu and click the Save

button.

Existing members of the workgroup are not affected by the workgroup’s default role change. Only users
who are subsequently added are assigned the new default role.

Assigning roles by user
After users are added to a workgroup, you can update each user’s role on a workgroup-by-workgroup
basis. This is often necessary if a user was given the default role when added to a workgroup, and you
want to assign a different role.

To update the role for a user in a workgroup:
1. Open your web browser and start the User Management application.

If it is already running, chooseWindow > Users and Workgroups.
2. In theWorkgroups pane, select the workgroup.
3. In the Users pane, select the username.
4. In the Details pane, click theWorkgroup tab.
5. Click the Show Permissions in Workgroup drop-down menu and choose the workgroup for

which you need tomodify the role. (Only workgroups in which the user is a member are
displayed.)

6. Choose a new role from the Role in Workgroup drop-down menu.
7. Click the Save button.
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Custom roles
In most instances, the predefined roles that come with Type Server should meet your needs. If you need
to set specific role settings, you can easily create a custom role.

For example, a production environment could require special settings for everyone in the department.

These users interact with outside clients, whomay supply fonts with their documents.

Production department users will need to add fonts to Universal Type Server, as well as collect fonts for
use on other systems.

In this example, you could create a “Production” workgroup and an associated custom role, “Production
User”.

The “Production User” role would have the permissions Add/Remove Fonts, Activate Fonts, andCollect
Fonts for Output.

When you set the “Production User” role as the default role for the “Production” workgroup, then all
users that you subsequently add to the workgroup will have this role, and the appropriate permissions.

To create a new role:
1. In the Management application, click User Roles.
2. In the User Roles work list on the left, click + .
3. In the Role Settings pane, change one or more of the permissions for the default role.
4. Click Save As, then enter a new name for the custom role and click Save.

To copy a predefined role:
1. In the Management application, click User Roles.
2. In the User Roles work list on the left, select a default role.
3. In the Role Settings pane, enter a role name.
4. Enable or disable user permissions (see Role-based permissions on page 42) for the new role.
5. Click Save to save the new role.

To delete a custom role:
1. In the Management application, click User Roles.
2. In the User Roles work list on the left, select the role to delete.
3. Click Delete , then click Delete to remove the role.

If you delete a custom role that is assigned to a user, that user’s role is changed to the Regular User
predefined role.
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Workgroups
In Universal Type Server, fonts are organized into workgroups—collections of fonts intended for a specific
job description, division, publication, or other grouping. Workgroups are like separate databases of
fonts, each with its own group of users. The Server Administrator decides which users belong to each
workgroup, and has the ability tomodify user permissions on a user-by-user basis for each workgroup.
To help facilitate setting user permissions, each workgroup has a default role, which sets the initial
permissions for users added to the workgroup.

Users can be members of one or more workgroups, and a user’s capabilities can vary from workgroup to
workgroup. So, a user could be able to add and remove fonts in one workgroup but not in another.

Tomaintain any existing organization you have for fonts, you can add collections of fonts to Universal
Type Server as workgroups. For example, if your fonts are organized by department, you can create
department-based workgroups. Teams for each account, magazine division or publishing team could
have their own workgroups. You can also create new workgroups using fonts already in existing
workgroups and you can change which fonts are in which workgroups.

Not to be confused with font sets—subsets of fonts within a workgroup—workgroups go beyond grouping
fonts to controlling usage and access.

When you create users, you specify workgroups to which they belong. In many configurations, users will
belong to only one workgroup (although they can simultaneously belong to and activate fonts in multiple
workgroups).

For example, a magazine publisher may have three font workgroups: Editorial, Art, and Production.
n The Editorial workgroup contains fonts used in body copy. Writers and editors are members of

this workgroup, and are given the permission to activate fonts, but aren’t allowed to add, delete,
or collect them.

n The Artworkgroup contains all of the fonts that the company owns; the graphic designers can
activate and add fonts, but they can’t delete or collect them.

n The Productionworkgroup encompasses all of the company’s fonts along with all of its
advertisers’ fonts. Users of this workgroup are given permission to add, delete, and collect fonts.

Some environments choose a simpler approach and only create one workgroup to which all fonts are
added, and all required employees are added as users. In these environments, it’s a good idea to create
a custom role that allows users appropriate access to fonts, and set that role as the default for the
workgroup.
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Defining a workgroup strategy
Before you start creating workgroups of fonts, you need to decide how youwant to structure them.
Unlike the way you probably have been managing fonts— by font name, foundry, etc.—think more
about who needs the fonts than about characteristics of the fonts.

For example, don’t create workgroups based on font characteristics such as foundries or classes. If you
do, most of the users will end up needing access to fonts in many workgroups, making access difficult to
manage. Users are able to sort fonts based on foundry and class in the Universal Type Client, so there is
little need to organize fonts by foundry in separate workgroups.

Another important consideration when planning workgroups is that, in general, each document you
design or output should use fonts from only one workgroup. So each workgroup should contain all the
fonts necessary to complete the projects its users are involved in. Since users can work in multiple
workgroups, it is important to configure workgroups so that users aren’t confused about which
workgroup they should be using.

It is easiest to select a sample configuration (Sample configurations on page 19) example and follow the
detailed instructions for setting up your workgroups using one of these models. If your environment
differs and requires a specialized configuration, spend a few minutes examining the fonts required in
your environment as well as your user’s font needs.

Creating and editing workgroups
New workgroups are created through the User Management application.

To create a workgroup:
1. Open your web browser and start the User Management application.

If it is already running, then chooseWindow > Users and Workgroups.
2. In theWorkgroups pane, click the + button. This opens the New Workgroup details pane.
3. Enter aWorkgroup Name. This is the name that is displayed to users who are members of the

workgroup.
4. Choose a Default Role from the drop-down menu.

The default role is set for users when they are added to the workgroup. When used properly, the
default role can make adding users and configuring permissions for a workgroup a snap.

5. Enter any Notes to help you identify the fonts that will be contained in this workgroup. Notes are
only visible in the User Management application, and are not visible in the client.

After creating a workgroup, the next step is to add users to that workgroup. After adding users, those
who have the appropriate permissions can add fonts to the workgroup using the Universal Type Client.
It’s important to remember that anything to do with the physical manipulation of fonts is performed
using the Type Client.

After creating a workgroup, youmay find that there’s another name that more accurately describes the
workgroup. You can easily change this as well as the default role after a workgroup is created.

To edit an existing workgroup:
1. Open your web browser and start the User Management application.

If it is already running, then chooseWindow > Users and Workgroups.
2. In theWorkgroups pane, select the existing workgroup.
3. In the Detail pane, change the workgroup name and/or default role and click the Save button.

NOTE: Any changes to the default roles affect only users subsequently added to the workgroup; these
changes do not affect users who are currently members of the workgroup.
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Deleting a workgroup
When a workgroup no longer serves a purpose, you can delete it. It’s important to understand what
happens to fonts contained within a workgroup when it is deleted.

n The users assigned to that workgroup remain in Universal Type Server.
n The workgroup is removed from the list in the Universal Type Client as well as from the User

Management application.
n If users have fonts from the workgroup active, the fonts stay active until the users shut down their

computers or choose Server > Forget Connection.
n If fonts in the deleted workgroup belong to other workgroups, they remain in the Type Server

datastore.
n If fonts in the deleted workgroup were exclusive to that workgroup, the fonts are deleted from the

server entirely.
n All font sets within the workgroup are deleted.

To delete a workgroup:
1. Open your web browser and start the User Management application.
2. In theWorkgroups pane, select the workgroup name.
3. Click the - button.
4. Click theOK button to confirm.
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Users
A user is any individual who needs to connect to Universal Type Server to access fonts. Each user will
have his own unique account name, settings, and permissions.

You can add as many users as required to the Type Server, regardless of how many user connections you
have purchased. Your license controls how many concurrent connections are allowed to the server.
Therefore, you can create a user for anyone who needs access to fonts— every full-time employee, part-
time employee, intern, client, etc.

When creating users, the administrator specifies all basic user login information: username, full name,
email address, and password.

After the user is created, users are then added to workgroups. When a user is added to a workgroup, the
user is automatically assigned the default role in that workgroup. The default workgroup role sets a wide
variety of user permissions, and is handy for quickly setting consistent permissions for all users in a
workgroup. If special user permissions are required, they can be set globally for that user or on a
workgroup-by-workgroup basis.

User logins can be used with the Universal Type Client on either macOS or Windows. The client is only
able to use font files that are compatible with the current operating system, so users whowork on both
platforms may have different fonts available for use. For example, Windows-based PostScript fonts are
not compatible with the macOS, so these fonts cannot be activated or collected by the macOS client.

NOTE: To prevent confusion, control access, and aid in troubleshooting, do not give multiple users the
same account name. For example, if you give all graphic designers the account name “Creative,” it
will be difficult to determine which user added a corrupt font.

The Server Administrator
There is only one Server Administrator account per Universal Type Server installation. The Server
Administrator can perform any administrative task from the Server Administration and User
Management applications as well as any task in the Universal Type Client.

Most importantly, the Server Administrator is the only user account that is able to assign or remove the Is
Full Administrator setting (see The Full Administrator setting on page 41), and cannot be deleted
from the server.

Typically, the only time youwould use the Server Administrator account is during the initial configuration
of the Type Server, and when you need to add or remove users with the Is Full Administrator setting.

The Server Administrator username is always set to administrator and the default password for the
account is password. For optimal security, change this password as soon as possible after installation.

IMPORTANT: Do not lose the Server Administrator password! This is the only username and
password that cannot be reset or recovered. If you do lose your Server Administrator password,
please contact Extensis technical support for assistance. See Support on page 62 for contact
information.
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Creating and editing users
Users can be added by Full Administrators and the Server Administrator.

To create a new user:
1. Open your web browser and start the User Management application

If you already have it open, then chooseWindow > Users and Workgroups.
2. In theWorkgroups pane select a workgroup to which youwould like to add a user. To add a user

without specifying a workgroup, select the All Users workgroup.
3. In the Users pane, click the + button.
4. In the New User details pane, click the Account tab and enter the basic account information:

n Account Name: Each user account name must be unique. It’s best to use an account name
that is short, easy to remember, and does not include spaces or letter case variations.

n Full Name:Optional field.
n Email Address:Optional field.
n Password:Optional field. If left blank, a password is not required for this user to log in.

If you enter a password, enter it again in theConfirm Password field.
n Notes: Enter any notes to appropriately identify the user. This information is only visible in the

User Management application.
5. Click the save button to add the new user.

After creating a new user, add the user to workgroups as required.

Typically, default user settings are all that is required for most users. The appropriate user permissions
are configured by the default workgroup role when you add this user to a workgroup. Although many
settings and permissions options are available tomodify on a user-by-user basis, it’s likely that youwill
never need to do so.

NOTE: All font manipulation happens in the Universal Type Client. Add fonts, remove fonts, add
keywords, and organize fonts into sets using the Type Client.

You can edit the user account information, settings, and permissions after the user is created.

To edit an existing user:
1. Open your web browser and start the User Management application

If you already have it open, then chooseWindow > Users and Workgroups.
2. In theWorkgroups pane select any workgroup to which the user belongs.
3. In the Users pane, select the user to edit.
4. In the Details pane, click the Edit button.
5. Update any of the user account information, settings, and permissions.
6. Click the Save button.
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Settings
User settings control a number of options about how users are given access to fonts, as well as enabling
administration privileges.

Change Password
The Change Password setting allows the user to update their password directly from the Universal Type
Client by choosing Server > Change Password.

Alternately, Full Administrators can change a user’s password directly through the User Management
application.

NOTE: If you are bound to a Directory Service and using Kerberos for single sign-on, theChange
Password command does not have any affect on domain passwords. This command only affects
Universal Type Server passwords.

Activate Fonts Across Workgroups
All users are able to simultaneously activate fonts in any workgroups to which they are a member. The
Activate Fonts Across Workgroups setting applies only to the auto-activation plug-ins installed on the
client’s system.

The Universal Type Server plug-ins are typically limited to activating fonts from a single workgroup.
When the user launches an application for which the Type Server plug-in is enabled, the user is
prompted to select a workgroup of fonts to use for auto-activation. Enabling this permission allows the
plug-ins to activate fonts from workgroups to which the user has access and are enabled in the plug-in.

Due to the fact that you can’t guarantee that all users will have access to all fonts, it is best to design
documents to only use fonts from a single workgroup. This way you can guarantee that all users of that
workgroup will have the fonts necessary for the document. The risk of enabling this feature is that a user
could unintentionally create a document that uses fonts frommultiple workgroups.
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Manage a Personal Workgroup
At the discretion of the administrator, users can add fonts to their own personal workgroup. Personal
workgroups can be either server-based or client-based.

n Server-based personal workgroups are available on any computer that the user logs in to. This
is a good setting if youwant to be sure that personal workgroups are available from any computer
where the user logs in, and to ensure that there is always a backup of personal workgroup fonts
on the server.

n Client-based personal workgroups are housed only on a single computer so the fonts contained
within these workgroups can vary from computer to computer for the same user account. Client-
based workgroups have the advantage that if a user attempts to add corrupt fonts, the corrupt
fonts are placed into a “corrupt fonts” set within the client-based personal workgroup.

Personal workgroups are useful when experimenting with fonts for which youmay only have a single
license. For example, say a graphic designer who is working on a new client’s identity is experimenting
with fonts that are not part of the company’s licensed font library. The designer believes the fonts are
ideally suited to the job and the administrator does not want to squelch the designer’s creativity. But,
since the company doesn’t yet own a large number of licenses for this font, you don’t want to add them
to the server for an entire workgroup to use. The solution is to have the designer add the fonts to his or
her personal workgroup. If the client approves the fonts, you can purchase additional licenses and add
the fonts to the appropriate workgroups.

Access to a personal workgroup is a user-based permission, so some users might have them while others
do not. For example, graphic designers are likely to need a personal workgroup, but editors are not.
Since the fonts are for private use, users can add, delete, activate, add attributes and collect for output
from their personal workgroup.

IMPORTANT: Changing the personal workgroup setting after a user has already added fonts and
sets to that workgroup will result in the deletion of all existing fonts and sets in the user’s personal
workgroup. It is best to specify the personal workgroup setting when adding a user and not modify it
after a user has started to work with the personal workgroup.

Enforce System Font Policy
System Font Policies are used to control which fonts can be added to the system font folder on a user’s
computer.

When a system font policy is enforced for a user, the Universal Type Client periodically checks which
fonts are in the system font folders and removes any unapproved fonts.

For complete details about System Font Policies, see System Font Policy on page 16.

Disable Startup Sets
This permission disables the activation of startup sets for the selected user. Youmay want to do this for
users whomay be part of a workgroup, but not need to activate fonts that are typically activated for all
users of the workgroup by startup sets.

Users will still see startup sets in their workgroup, but the fonts are not be automatically activated. Fonts
in these sets can be manually activated if desired.
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Time Between Server Syncs
To keep all of the fonts, font attributes, and user permissions current in all Universal Type Clients, the
client synchronizes data with the server on a periodic basis.

How often each user account synchronizes with the Universal Type Server is controlled by the Time
between server syncs user setting. This setting is adjustable so that administrators can help minimize
network traffic while ensuring that all clients are kept up to date.

Synchronization takes place only while the client is connected and working online with the Type Server.
After working offline, the client automatically synchronizes with the server, downloading all attribute
changes and permissions. Fonts are downloaded to the client based on each user’s Font Replication
Mode (see Font Replication Mode below).

The synchronization interval for each user can vary based on that user’s needs. For example all users of
a production department may work on the same project at the same time. All of these users will need the
same fonts at the same time, so a very short synchronization interval would benefit this environment.
Alternately, a copy editor whoworks on just a few projects with a fairly static group of fonts would not
need to be constantly synchronizing with the server. A longer interval, perhaps daily, would be more
appropriate for this user.

A more frequent synchronization setting can create unnecessary network traffic and potentially slow
down your network. So, set your synchronization frequency to the a longer interval to keep network
traffic to a minimum.

Font Replication Mode
The Font replication mode setting controls when fonts are downloaded to the client system. Font
replication is important to understand to keep your network traffic to a minimum and tomaintain
healthy server performance.

Depending upon the type of use that you expect, and tominimize network traffic, each user may have a
different replication mode.

n All: This replication mode automatically downloads all fonts from the workgroups to which the
user is a member. This is a good setting for users whowill frequently be working offline, and who
need access to a wide variety of fonts.

n On-Demand: This mode downloads fonts as they are required. Previewing, activating and
collecting fonts initiates the download of selected fonts to the client computer. When fonts are no
longer required, they are removed and are not stored in the Type Client font cache. Only fonts
that are currently active or being previewed are available while working offline.

n On-Demand Local Cache: This replication mode downloads fonts to the client as they are
requested. Previewing, activating, and collecting fonts all initiate the download of a font. After
being downloaded from the server, fonts are not removed and remain in the Type Client cache.
Cached fonts are available for activation, preview, and collection while working offline.
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Font replication and licensing issues
The font replication mode that you choose can be affected by how you expect to account for the
licenses for your purchased fonts. Fonts are each small pieces of software, each with their own license.
Youmay have purchased fonts as part of a large library or one at a time. Either way, you need to be sure
that you’re using fonts in a way that you aren’t compromising the font’s license.

n The All replication mode downloads all workgroup fonts to a user’s system. Each and every font in
workgroups to which the user is a member is always downloaded to the user’s system, and thus
may require a license for that font file.

n TheOn-Demand replication mode only downloads files to a user’s system when they are
required. When the font is no longer in use, it is removed from the system and no longer consumes
a font license.

n TheOn-Demand Local Cachemode only downloads fonts as requested. So, if a user has
previewed or activated a font, it is considered in-use by the system, and consumes a font license
at that point. Since fonts are not removed from the user’s system, all fonts remaining on the
user’s system continue to consume licenses.

Updating user settings for multiple users
Settings can be updated for multiple users at the same time by selecting multiple users in the User
Management application.

TIP: Youmay also want to designate default server settings (see New user defaults on page 14) that are
automatically applied to users as they are created.

The following settings may be changed for multiple users at the same time:
n Change password
n Activate fonts across workgroups
n Time between server syncs
n Font replication mode
n Has Personal Workgroup (server-based or client-based)
n Enforce System Font Policy
n Disable Startup Sets

NOTE: The Full Administrator setting (see The Full Administrator setting on page 41) and other account
settings such as password, full name, and notes cannot be updated for multiple users at the same time.
It is also important to note that users who are currently Full Administrators cannot be updated in a group
with other users, and must be updated individually.

To edit the user settings for multiple users:
1. Open your web browser and start the User Management application.
2. In theWorkgroup pane, select a workgroup.
3. In the Users pane, select multiple users by SHIFT-clicking the first and last users, or by CTRL-

clicking (Windows) or COMMAND-clicking (Mac) multiple users in the list.
4. In the Details pane, select the settings to apply or remove from all selected users and click the

Save button.

TIP: Use the Roles feature (see User roles on page 27) to quickly apply and update permissions for
multiple users.
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Adding users to workgroups
For a user to have access to fonts in a workgroup, youmust first add the to the workgroup. You can add
a user into a workgroup when you create it, or you can drag an existing username into a workgroup.

To add an existing user to a workgroup:
1. Open your web browser and start the User Management application.

If it is already running, chooseWindow > Users and Workgroups.
2. In theWorkgroups pane, select the All Users workgroup, or any other workgroup to which the

user currently belongs.
3. Drag a user name from the Users pane into any other workgroup.

The user is automatically assigned the default role in the new workgroup.
4. You can now edit the user’s permissions for the new workgroup in theWorkgroup tab.

To add multiple users to a workgroup:

Follow the steps above, but select multiple users and drag the selected group from the Users pane into a
workgroup.

(To select multiple users, hold down theCOMMAND key (Macintosh) or CTRL key (Windows) and click on
each user.)

To add users tomultiple workgroups:
1. Select the users.
2. Right-click on one of the selected users.
3. Choose Add to Multiple Workgroups from the pop-up menu.
4. In the resulting dialog, check the box next to each workgroup that youwant to add the users to.
5. Click theOK button.

You can also choose Add to All Workgroups from the pop-up menu to add the selected users to all
workgroups.

Applying a role
You can apply a different role to a user for each workgroup they are a member of.

To change a user’s role for a specific workgroup:
1. Click Users in the workspace list at the top of the window.
2. Select the user in the list on the left.
3. In the User Account Data panel, click Permissions.
4. Select the workgroup from the Permissions for Workgroup pop-up menu.
5. Select the role that youwant to assign to the user in that workgroup from the Role Assigned in

Workgroup pop-up menu.
6. Click Save.
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Permissions
Permissions control what a user is allowed to do in workgroups. Permissions can be set globally, so that
they affect all workgroups for a user, or on a workgroup-by-workgroup basis.

Permissions control the ability to:
n Add and remove fonts
n Collect fonts for output
n Create, delete and modify shared sets
n Create and delete startup sets that are permanently active for all users
n The ability to create, delete and apply attributes to fonts

In most cases, it is best to allow permissions to be set by the user’s role within each workgroup. Yet, for
some users, youwill need to specifically edit user permissions. Typically, youwill need to edit permissions
for users who need extra abilities within a workgroup. For example, in a workgroup where all users are
given the Regular User default role, youmay want to give one user responsibility for creating keywords.
To do so, for this user the administrator would grant theCreate and Delete permission for Keywords.

The Full Administrator setting
The Is Full Administrator setting allows a user to perform most of the administration tasks available
through the User Management application.

For each Type Server, typically only one or two users will have the Is Full Administrator setting. The Is
Full Administrator setting can only be assigned by the Server Administrator (see The Administrator
account on page 13).

Full Administrators are users who are primarily responsible for the high-level workgroup and user
organization, and are likely members of the IT department.

The Is Full Administrator setting allows a user to:
n Assign the Workgroup Administrator permission to a user.
n Create and delete users in any workgroup.
n Modify permissions and settings for any user in any workgroup.
n Rename and regroup font families.
n Delete any sets that have been shared by other users.
n Create and edit font licenses.
n Create and edit Directory Service mappings.
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Global permissions
Global permissions grant users permission to perform actions across all workgroups to which the user
has access.

All global permissions are set by the user’s role within each workgroup, and using roles is the
recommended method for applying user permissions.

Though, there may be some instances where youwant to globally grant a single user extra
responsibilities across all workgroups. For example if there is a user whowill be primarily responsible for
collecting fonts frommultiple projects for archiving, the administrator would enable theCollect Fonts
for Output global permission for that user.

Globally granted permissions override any permissions set by a user’s role in the workgroup, as well as
any custom workgroup permissions.

Global permissions include both font-based permissions and font attribute permissions.

Font-based permissions include the ability to:
n Collect Fonts for Output
n Add and Remove Fonts
n Create and Delete Startup Sets

Font attributes are only stored within Universal Type Server and never applied to the source font file.
Font attributes include all font licensing, keywords, styles, classifications, foundries and font family
information. Administrators can grant or deny the ability to create, delete, and apply:

n Licenses
n Keywords
n Styles, Classifications, Foundries, and Families

Role-based permissions
The following permissions can be granted or denied to each user on a workgroup-by-workgroup basis. A
user’s role for each workgroup is set in the Workgroup permissions tab of the User Management
application.

Role-based permissions can be overridden, allowing the administrator to grant or deny permissions
globally for a user, or on workgroup-by-workgroup basis for each user.

Each permission has a three-state check box that switches between the role permission and whether the
permission is custom granted or denied. If a permission is granted globally, it cannot be modified in the
Workgroup tab.

Add and Remove Fonts
This permission allows the user to add font to and remove fonts from a workgroup. This is an important
responsibility, because if a font is removed from a workgroup, and if it doesn’t belong to any other
workgroup, it is immediately removed from the Type Server. Enable this permission for users who are
aware of this responsibility.

Collect Fonts for Output
This permission allows users to export fonts from the Type Server to a location outside of the server. Users
may need to do this when sending a project from one company location to another.

NOTE: Remember that fonts are individual pieces of software, and each font has specific font licensing
requirements. Only collect and provide fonts to others whom you know have purchased the appropriate
font licenses.
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Create/Delete Shared Sets
All users can create and modify their own sets in all workgroups for which they are a member. The sets
are associated with each username and are therefore available only to that user.

To allow the user to share a sets with the entire workgroup, check the box labeledCreate/Delete Shared
Sets. This can be helpful when users are creating a group of fonts to be used with a project. When the
user finalizes the set and wants to bring others onto the project they share the set with the entire
workgroup. So, in general, reserve this permission for project leaders.

Enabling this permission also allows the user to unshare any set that they have shared, making it
unavailable to others in the workgroup. The owner can also delete any sets that they have shared.

Modify Shared Sets
Check the box labeledModify Shared Sets to allow the user to add and remove fonts from all shared
sets, as well as rename any shared set. The user can modify any shared set, including those created by
other users.

Create and Delete Startup Sets
Enabling this permission allows users tomake any set permanently active for all users of the workgroup.
Fonts in startup sets cannot be overridden or deactivated by client users. This is handy to activate a
standard set of corporate fonts for all users in a workgroup.

The only way to deactivate or override fonts in startup sets is to remove the startup status of the set.
Only users who have this permission are to disable a startup set. Removing the startup set status allows
all users of the workgroup to deactivate and override fonts in the set.

Font attribute options
Controlling font attributes helps organize fonts. Font attributes includes font licenses, keywords, styles,
classifications, foundries, and family information. Font attributes are stored only within Universal Type
Server and in no way affects your original font files, so attributes are helpful for organizing and finding
files. For example, keywords can be added to all fonts used for a project, client, or print job. Fonts can
later be found using this information.

Administrators can set these permissions using three methods:
n Set by the user role
n Custom granted or denied in a user’s Global permissions
n Custom granted or denied in a user’s Workgroup permissions

All permissions can be set so that the user can create and delete attributes, or merely apply that item to
fonts. For example, youmight have one person who creates your list of keywords, yet everyone might
have the ability to apply keywords to fonts.

Keywords: Keywords are a good way to track fonts. You can create a keywording strategy that helps
you track which fonts are used for specific projects or clients. As with the example used above, youmay
only have a few users who can create and delete keywords, but many users who are able to apply them
to fonts.

Styles, Classifications, Foundries, and Families: Enable this permission for users who need tomodify
Styles, Classifications, Foundries and Families. Typically these users create fonts or are those who
absolutely know which foundry fonts came from. Enabling this permission also allows users to change
how the Type Client displays font family information. For example, if you believe that a font would better
belong in another family group, you can drag that font file to another family.
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Workgroup permissions
Workgroup permissions are permissions that are restricted to a specific workgroup. Administrators can
use this tab to grant or deny permissions for each user on a workgroup-by-workgroup basis.

Permissions on theWorkgroup tab are broken down for every workgroup to which the user belongs. Use
the Show permissions for Workgroup drop-down menu to change which workgroup permissions are
displayed.

All of the workgroup-based permissions can be set by the user’s role in the workgroup, although custom
permissions can be granted or denied.

NOTE: If a permission is granted or denied in theGlobal permissions tab, it cannot be modified in the
Workgroup tab.

Use the Role in Workgroup drop-down menu to select the user’s role for the workgroup displayed in the
Show permissions for Workgroupmenu above.

A star * displayed next to the Role in Workgroup drop-down menu indicates that there have been
custom workgroup permissions applied in theWorkgroups tab. This is an easy way to see if the
workgroup permissions are different than the default role permissions.

Font-based permissions can be granted or denied on a workgroup level. These include the ability to:
n Collect Fonts for Output
n Add and Remove Fonts

All users can create their own sets within a workgroup. For sets to be visible to other users, the set must
be shared within the workgroup. As an example, youmay want to allow a user to create and delete
shared sets, for a workgroup, but restrict their ability tomodify the shared sets from other users. Shared
set permissions include:

n Create and Delete Shared Sets
n Modify Shared Sets
n Create and Delete Startup Sets

Font attributes are only stored within Universal Type Server and never applied to the source font file.
Font attributes include all font licensing , keywords, styles, classifications, foundries, and font family
information. Administrators can grant or deny the ability to create, delete, and apply:

n Licenses
n Keywords
n Styles, Classifications, Foundries, and Families
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Active Directory
Universal Type Server can connect with your organization’s Active Directory service to give AD users
access to Type Server workgroups.

You can:
n Map Active Directory users to Type Server workgroups, allowing those users to log in to Type

Server using their network login credentials.
n Map AD groups to workgroups, so changes in AD group membership are automatically reflected in

Type Server workgroups.
n Use Kerberos Single sign-on so users only need to log in to their workstation to have access to the

Type Server.

There are two parts to configuring Universal Type Server for Active Directory:
Connecting to the Active Directory service below
Mapping Active Directory users to workgroups on page 47

There are additional steps you can take tomake user log-in more seamless and secure:
Kerberos Single sign-on on page 48
Configuring the client software on page 51

Connecting to the Active Directory service
NOTE: Only the Type Server administrator account can create a Directory Services configuration.

In the Management application, click the account menu (Administrator) at the top right of the main
window, then choose Directory Services.

Click theConfiguration tab in the Directory Service dialog.

If there is an existing configuration that you don’t want to use, click Delete to remove it.

Connection
In theConnection pane, enter the connection settings of your Active Directory service.

Hostname: The IP address or DNS name of your AD server.
Port: The port to connect to on the AD server. You can assign different ports for secure (SSL) and

standard (LDAP) connections. Select the port to use.
Username: Enter an AD user name that has permission to query the AD service. Enter the user name

as one of:
n domain\user, such as mycompany\jsmith
n user@realm, such as jsmith@mycompany.com
n The fully qualified LDAP distinguished name (DN), such as

uid=jsmith,cn=users,dc=MARR,dc=MYCOMPANY,dc=COM
Password: Enter the password for the user name that you entered.

IMPORTANT: Once you have successfully configured your AD connection, you cannot change the
Hostname through this pane (for instance, if youmove your Active Directory service to a new server
system). You can either delete the configuration and create a new one (and lose all your existing
mappings), or see the article Changing the Configuration in Directory Services.

Changing the Configuration in Directory Services: https://help.extensis.com/hc/en-us/articles/360039840713

https://help.extensis.com/hc/en-us/articles/360039840713
https://help.extensis.com/hc/en-us/articles/360039840713
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Update Policies
Specify when the Type Server syncs with the Active Directory service, and what happens to AD users
that have been deleted.

Sync with Directory Service:Choose to have your Type Server synchronize with the Active Directory
service once a day at a specific time, or at more frequent intervals. (Any change that youmake to
user mappings will be synchronized immediately, regardless of this setting.)

Delete UTS users when removed from Directory Service:When this option is turned on, then when
a user is removed from the Active Directory service, their account will also be removed from your
Type Server.

When this option is turned off, then when a user is removed from the AD service, their Type Server
account will be converted to a native account. If it previously did not have a native password
assigned, the password will be the same as the user name. (A user can change their native
password from within the Universal Type Client.)

Client Authentication
Choose the style of authentication youwill use for Active Directory users connecting to your Type Server.

LDAP Bind: AD users log in with their network login credentials (user name and password).
Single sign-on with Password: Youwill need to enter the Service Principal Name and password. See

Kerberos Single sign-on on page 48.
Single sign-on with Keytab: Youwill need to have copied your keytab file to your Type Server, then

enter the Service Principal Name. See Kerberos Single sign-on on page 48.

NOTE: For Single sign-on options, click Test to ensure that your connection is working.

Specify the behavior of native accounts.
Enable UTS Usernames and Passwords: If the Delete UTS users when removed from Directory

Service option is turned on (as described under Update Policies above), then this settings has no
effect whether turned on or off.

If the Delete UTS users… option is turned off and this option is turned on, a user can use either their
Active Directory or native password to log in. (If you don’t specify a native password for the user
account, it will default to the same as the account’s user name.)

If this option and the Delete UTS users… option are both turned off, then the user will only be able to
log in using their Active Directory password. If the user account is deleted from the AD service, the
user can still log in using their native account.

Once you have completed theConfiguration settings, click Save. (This automatically switches to the
Mapping tab of the Directory Service dialog.)
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Mapping Active Directory users to
workgroups
NOTE: Only the Type Server administrator account, or an account configured as a Full Administrator,
can map Active Directory users to Universal Type Server workgroups.

In the Management application, click the account menu (Administrator or your Full administrator
account name) at the top right of the main window, then choose Directory Services. (If Directory
Services is not available and you are logged in with a Full Administrator account, then the Type Server
administrator needs to create an Active Directory configuration.)

If you have already created an Active Directory configuration, theMapping tab will be displayed. (If the
Configuration tab is displayed, you need to enter the information about your AD server and set some
policies. SeeConnecting to the Active Directory service on page 45.)

You can map Active Directory accounts to workgroups you have set up on your Type Server. If you have
no workgroups configured, the Management app will prompt you to create one. (If you choose not to
create a workgroup at this time, youwill be returned to the main window.)

Using the Directory Service Browser
The Directory Service Browser allows you to query your Active Directory server to locate users,
distribution groups, organizational units (OUs), and security groups.

The Directory Service Accounts list shows the results of the query.

The search base
A query is basically the combination of a search base and query filter. The search base can be used to
restrict your search to just one part of the LDAP directory. This can be especially handy if your Directory
Service is configured to include discrete branches of users and groups by location or department.

The query filter
The query filter helps you locate users, groups and OUs within the search base.

You can access a number of pre-built query filters from theQuerymenu.
All Groups: Displays all groups within the search base.
Organizational Units: Displays all OUs in the search base.
Distribution Groups: Displays all distribution groups within the search base.
Security Groups: Displays all security groups within the search base.
Users: Lists all users; excludes all groups.

At the bottom of theQuerymenu, you can choose Search to search for users by name. You can search if
a user name contains, starts with, or equals the entered text.
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Tomap users:
1. Select a workgroup from theWorkgroupmenu in the UTS Workgroups pane on the right. You

can also click + to create a new workgroup immediately.
2. Select one or more users or groups in the Directory Service Browser on the left.
3. Drag the selected users into the Source | Role list on the right.

You can use the menu at the right of each Source | Role entry to specify the role for each user (or
all users in a group).

4. Click Save to save your user mapping.

Other details
1. You can select a user, group, or even a single group member in the Source | Role list and click

Delete Source to remove just that user or group from the mapping.
2. You can select a user in the Directory Service Accounts list, then click Exclude User . This will

add the user to the Source | Role list as an Excluded User. This can be convenient if a user should
always be excluded from your Type Server, nomatter how their Active Directory group
membership may change. (This may be true of contractors, for example.)

Kerberos Single sign-on
Kerberos is a secure protocol for authenticating users. With Kerberos, a user’s password is never
transmitted.

Single sign-on allows a user to log in once and gain access tomultiple unrelated services. A familiar
example is when a user logs in to a network workstation and can access shared network drives, email,
and a corporate intranet without additional login prompts.

Universal Type Server can utilize Kerberos Single sign-on tomake user connections simple and secure.
With Kerberos Single sign-on in place, users can log in to their workstation and start interacting with
Universal Type Server without any additional steps required.

The basic steps to configure Kerberos Single sign-on with Universal Type Server are as follows:
1. Create a Service Principal for your Type Server in your Active Directory (AD) service.
2. Optionally export a keytab file from your AD service and store it on your Universal Type Server.
3. Specify your Single sign-on method of Client Authentication when you connect your Type Server

to your AD service.
4. Optionally provide end users with a configuration file that allows Universal Type Client to identify

your Universal Type Server and connect automatically without input from the user.

The keytab option
The keytab file is an encrypted file that is stored on the Universal Type Server. This file, which is created
by your Active Directory service, allows Universal Type Server to perform Kerberos authentication without
the need to store a password locally.

The keytab file provides the strongest security available under Kerberos authentication.
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The config file option
To allow Universal Type Client and Core Client users to connect quickly with Universal Type Server,
administrators can create and deploy a configuration file that contains connection information. When
this file is placed on each client computer, the login dialog is pre-filled with the correct server address
and port.

When used in conjunction with Kerberos authentication, this can provide hands-off login to Universal
Type Server.

This can be especially useful on workstations that are shared by multiple users with unique log-ins;
Universal Type Client will connect automatically using the network login credentials for each user.

Configuring Kerberos for Active Directory
Even though Active Directory is Windows-based, Universal Type Server installed on either macOS or
Windows Server can connect to an Active Directory service. Mac and Windows Universal Type Clients
and Core Clients can also utilize Kerberos Single Sign-On under Active Directory.

Creating the Service Principal Name (SPN)
Because Universal Type Server is a Java enterprise service, Active Directory treats it as a Unix service, not
a Windows service. In order for Single Sign-On clients to connect to a non-Windows service like Universal
Type Server, Active Directory requires a Service Principal Name associated with a user account
representing the service.

At its simplest, a Service Principal Name is of the form <service_type>/<host_address>. For Universal
Type Server, the <service_type>must match the name of the Active Directory user account. <host_
address> can be the IP address or fully-qualified domain address of your Universal Type Server.

Create a user account:
1. Click Start > Programs > Administrative Tools > Active Directory Users and Computers.

The account name can be anything but must be unique. It will also be used as part of the Service
Principal Name that your Type Server uses to authenticate domain users.

2. Give the account a non-expiring password.

Map the account to the Service Principal Name:
1. Open a command prompt window.
2. Enter the following command. Replace the parameters enclosed in <angle brackets> with

information appropriate to your environment.
ktpass -princ <service_account>/<host_address>@<REALM> -mapUser <service_account> -pass
<service_account_password> -ptype KRB5_NT_PRINCIPAL
n <service_account>: The Active Directory user account you created previously.
n <host_address>: The IP address or fully-qualified domain name of your Universal Type Server.
n <REALM>: The realm where your Kerberos database is stored, in ALL CAPS.
n <service_account_password>: The password for the Active Directory user account.

The command output will indicate whether the mapping was successful.
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Creating a keytab file for Active Directory
This step is only necessary for configurations using Kerberos Single Sign-On with Keytab authentication.

Create the keytab file:
1. Open a command prompt window.
2. Enter the following command. Replace the parameters enclosed in <angle brackets> with

information appropriate to your environment.
ktpass -out <keytab_file_path> -princ <service_principal_name>@<REALM> -mapUser <service_
account> -pass <service_account_password> -ptype KRB5_NT_PRINCIPAL -cryptoALL
n <keytab_file_path>: The complete path where the keytab file will be generated. Youwill

eventually move the file from this location so it can be anywhere that you have write access.
The keytab file must be named universaltype.keytab.

n <service_principal_name>: This must be the <service_account> followed by a slash /
character, followed by the <host_address> of your Universal Type Server. For example,
MyTypeServer/196.0.10.123

The command output should indicate that the keytab file was successfully created in the location
specified.
Example:
In this example, the service account is MyTypeServer and its password is agent86smart.
ktpass -out C:\temp\universaltype.keytab -princ MyTypeServer/196.0.10.123@EXAMPLE.COM -mapUser
MyTypeServer -pass agent86smart -pType KRB5_NT_PRINCIPAL -cryptoALL

3. Move the universaltype.keytab file to your Universal Type Server, in one of the following
locations:
n For Windows servers, move the keytab file to C:\Program Files\Extensis\Universal Type

Server\data\sso\universaltype.keytab
n For macOS servers, move the keytab file to /Applications/Extensis/Universal Type

Server/data/sso/universaltype.keytab

Information for the Type Server connection
When you connect your Universal Type Server to your Active Directory service (seeConnecting to the
Active Directory service on page 45), youwill need to provide some of the information used in the
previous sections.

n If you are using Single sign-on with Password, youwill need the <service_principal_name> and
the <service_account_password>.

n If you are using Single sign-on with Keytab, youwill just need the <service_principal_name>.

Active Directory and failover servers
If your Universal Type Server installation includes a failover configuration, there are some specific issues
to consider when using an Active Directory service.

n Youwill need to create two service accounts, one for each Type Server. The names of these
accounts cannot be the same.
This means that the Service Principal Name for each server will have different service types as well
as different host addresses.
Examples:uts_primary/198.0.2.10@LDAP.EXAMPLE.COM and uts_
secondary/198.0.2.11@LDAP.EXAMPLE.COM.

n Since the service account password is stored in the shared Type Server database, the service
accounts for the Primary and Secondary servers, while having unique account names, must use
the same password if your connection does not use a keytab file.
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Configuring the client software
You can add a configuration file to systems with Universal Type Client or Core Client installed. This file
contains the network address of your Universal Type Server. By installing this file, users do not need to
enter the server connection information when they start Universal Type Client or Core Client. If you also
have Kerberos Single sign-on configured, users will not be presented with a login dialog; they will be
automatically connected using the credentials they used to log on to their workstation.

It is also important to know the differences between Directory Service (LDAP) and native Universal Type
Server accounts, and when a user might need to use one instead of the other.

The client configuration file
To allow Universal Type Client and Core Client users to connect quickly with Universal Type Server,
administrators can create and deploy a configuration file that contains Type Server connection
information. When this file is placed on each Type Client or Core Client computer, the login dialog is pre-
filled with the correct server address and port. When used in conjunction with Kerberos authentication,
this can provide a seamless login (Single sign-on) to Universal Type Server.

Parameters
The configuration file follows the basic format of parameter=value. The following parameters can be set:

PARAMETER DESCRIPTION

server.address The Universal Type Server address. If you specify server.address,
youmust also specify server.port.

server.port The port number of Universal Type Server. Youmust specify
server.port if you specify server.address.

server.bonjour The Bonjour name of the server, if one exists. If you specify
server.bonjour, it takes precedence over server.address and
server.port declarations.

For example, if your Universal Type Server is at the IP address 10.1.2.34 using the default port, your
configuration file would contain the following parameters:
server.address=10.1.2.34
server.port=8080

If you choose a Bonjour name for your server instead, the file only needs to contain a single parameter.
For example, if you gave your Type Server the Bonjour name “FontServer” the configuration file would
contain the following parameter:

server.bonjour=FontServer

IMPORTANT: The configuration file must end with an empty line; press ENTER or RETURN after your
final configuration parameter.
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File format
The configuration file must be saved in UTF-8 format.

For Universal Type Client:

The configuration file must be named com.extensis.UniversalTypeClient.conf.

Place it in the following location on the computers where you have installed Universal Type Client:
n 64-bit Windows: C:\Program Files (x86)\Extensis\Universal Type Client\
n 32-bit Windows: C:\Program Files\Extensis\Universal Type Client\
n Macintosh: /Library/Preferences/

For Core Client:

The configuration file must be named com.extensis.TypeServerCoreClient.conf.

Place it in the following location on the computers where you have installed the Core Client:
n 64-bit Windows: C:\Program Files (x86)\Extensis\Type Server Core Client\
n 32-bit Windows: C:\Program Files\Extensis\Type Server Core Client\
n Macintosh: /Library/Preferences/

Saving a file in UTF-8 format
The UTF-8 file format is a common standard; however, youmay experience difficulty with your config file
depending on the program you use to create it.

Windows
You can use either Notepad or WordPad to create your config file.

In Notepad, save the file using the ANSI encoding (do not use UTF-8 from Notepad; this adds a byte
border marker, or BOM, which is not recognized by Universal Type Client.)

In WordPad, save the file as an MS-DOS format text document. (WordPad’s Unicode is UTF-16 Little
Endian fomat, which is not recognized by Universal Type Client.)

To create your configuration file using an alternative editor to either Notepad or WordPad, we suggest
using the excellent and free text editor, Notepad++, available for download from http://notepad-plus-
plus.org/. Before saving, be sure to select Encoding > UTF-8.

Macintosh
You can use TextEdit to save your config file in the proper format.

First, make sure the file is formatted as plain text. Choose Format > Make Plain Text. (If the menu reads
Make Rich Text, then the file is already in plain text format.)

In the Save As dialog, choose Plain Text Encoding > Unicode (UTF-8). (If this option is not available,
choose Plain Text Encoding > Customize Encodings List, check the box for Unicode (UTF-8) near the
top of the Custom Encoding List, then choose the correct encoding from the pop-up menu.)

Make sure the file name ends with .conf and the option to use the .txt extension (at the bottom of the
Save As dialog) is turned off. (You can also turn off the automatic .txt extension in the TextEdit
Preferences dialog.)

Finally, click Save.

BBEdit is a high-powered text editor for macOS from BBEdit that includes a very capable “free” mode. If
you use BBEdit to edit your config file, set the encoding toUnicode (UTF-8) in the Save As dialog when
you save your file.

Notepad++: http://notepad-plus-plus.org
BBEdit: https://www.barebones.com/products/bbedit/

http://notepad-plus-plus.org/
http://notepad-plus-plus.org/
https://www.barebones.com/products/bbedit/
http://notepad-plus-plus.org/
https://www.barebones.com/products/bbedit/
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Fonts
The Fonts workspace shows all the fonts available on your Universal Type Server.

You can filter the list of fonts in several ways: by Font Licenses,Connected Users,Workgroups, or
Font Compliance Status.

Choose a filter from the pop-up menu, then choose one or more of the items from the list on the left (a
license, user, workgroup, or compliance status).

The list of fonts on the right will display those fonts that match the filter selection.

For example, to list all unlicensed fonts, choose Font Compliance Status from the Filter By pop-up
menu, then click Unlicensed in the list below.

You can also search the list of fonts; the text you enter in the Search field will be matched against all
displayed fields (PostScript Name,Menu Name, Foundry, Type, Version, and Font Sense ID).

Adding fonts
Adding fonts individually
Universal Type Server makes it easy to add fonts by searching through volumes, folders, and files to
locate font files for you.

To add fonts to a workgroup:
1. Launch the Universal Type Client.
2. Select any item containing fonts—your hard drive, CDs, flash drives, network volumes, folders, or

files—on the desktop.
3. Drag your selection into the Fonts pane to add them to the selected workgroup. You can also drag

fonts onto a workgroup name or into a set within a workgroup.

NOTE: If the File > Add Fonts command is gray, you do not have the necessary user permission to
add fonts to the selected workgroup.

Adding fonts as sets
To retain any current organization you have for fonts—for example, if you have folders of fonts for
specific projects—you can add the fonts as sets. Each folder becomes a set with the same name and
contents as the folder. The individual fonts are available to the entire workgroup and you can share the
sets with the workgroup (if you have share sets permission).

To add fonts as sets, do one of the following:
n Choose File > Add Fonts, or pressCOMMAND-L (Mac) or CTRL-L (Windows). Use the Add Fonts

dialog to locate and select a folder of fonts, then click Add. A set is automatically created from
the folder you select.

n Select folders on the desktop that contain fonts. Drag the folders onto a workgroup in the
Workgroups pane of Universal Type Client.

NOTE: Universal Type Client lets you create nested sets (sets within sets), but it does not
automatically create them as you add folders of fonts. All the fonts within a folder will become a
single set even if many folders of fonts are nested within the first folder. If you need to add nested
folders as individual sets, select those folders and add them independently.
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Font licenses
Universal Type Server allows you to associate fonts with information about their respective license
agreements.

n The Font License is the instrument that allows Type Server tomanage and report on font license
compliance. Fonts that are not assigned to a license cannot be monitored for compliance.

n You create and edit license information in the User Management application.
n You can apply font licenses from either the Universal Type Client or User Management.
n Since youmight purchase a font multiple times, a font can be assigned tomultiple licenses.
n Since youmight purchase multiple fonts at one time from the same supplier, multiple fonts can be

assigned to a single license.
n Font licenses are added globally so the same license will apply to the font across all workgroups.
n Only Full Administrator users can create or edit licenses.

Developing a font license strategy
To create effective licenses, youwill need to carry out the following tasks:
1. Locate all of your End User License Agreements for the fonts you own.

If you are unable to locate them, contact the foundries directly to receive a copy.
2. Verify which fonts each license applies to.
3. Consider an identifiable name for each license youwill store in your Type Server.
4. Consider whowill manage your licenses.

n Will it be a shared task, or will one person be responsible?
n Whowill create licenses, whowill apply them to fonts, and when will they do this?
n How do you intend to handle unlicensed fonts and whowill be responsible for monitoring this?

NOTE: You should always keep a hard copy or digital version of original End User License Agreements as
proof of your license ownership.

For consistency and maximum efficiency, consider the following:
n Use standard naming conventions for licenses. If you have three different types of licenses from

Adobe, youmay need to be able to distinguish them from each other.
n Standard use of theComments field, which lets you store additional information with licenses.

For example, youmight use this field to indicate which department licensed the font.

Creating, editing, and deleting licenses
To access licenses, chooseWindow > Fonts and Licenses.

To add a license:
1. Click + in the Licenses pane.
2. Enter the license information.

License name: Enter a descriptive and unambiguous name for the license.
Number of seats: How many computers each font in the license can be installed on.
Enforcement mode: Strict to have Universal Type Server automatically decline to allow more
computers than the number of seats to activate the font, or Notify only to be notified if a font is
activated more times than there are seats available.
Other information is generally optional, but consider using it as part of your licensing strategy
and compliance plan. SeeOther parts of a license on the next page for details.

3. When you have finished entering the license information, click the Save button.
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To edit a license:
1. Select a license in the Licenses pane.
2. Click the Edit button.
3. Modify the license information.

SeeOther parts of a license below for details about optional information you can add to your
font licenses.

4. Click the Save button.

To delete a license:
1. Select a license in the Licenses pane.
2. Click -.
3. In the confirmation dialog, click theOK button to delete the license or click theCancel button to

keep it.

Other parts of a license
You can add more information to the license that you store in Universal Type Server to aid in your
compliance goals, record keeping, and purchasing. The categories available are:

n Terms of Use: Add information about how the fonts covered by the license are allowed to be
used.

n Purchase Information: Add information about when and how you purchased the fonts
associated with the license.

n License Details: This displays when the Type Server License entry was created and who created
it, and when it was last modified and whomodified it.

n License Agreement Documents: You can upload files related to your license, such as a scan of an
invoice or an email that includes license information.

To view any of these information categories, click on the category header. Click on the header again to
hide the information.

Terms of Use
The Terms of Use section indicates how the fonts covered by a license can be used.

This might include whether fonts can be embedded in documents, or whether fonts can be supplied to a
third party service provider to create your final output.

You can assign up to 10 terms to each font license.

Although Universal Type Server initially includes some sample terms, you can add your own, and you can
edit or delete the original contents.

n To add a term to the list for the current license, choose one from the pop-up menu below the list
and click + .

n To remove a term from the license, select it in the list and click - .
n To add terms to the pop-up menu, choose Edit Terms of Use list from the menu, then click + in

the resulting dialog, type your new term, press the ENTER key, then click the Save button.
n You can also add comments below the list of terms.

Purchase information
You can add information related to your purchase records for your font license.

To enter dates, click the date field or the calendar icon , then choose the month, year, and day of the
month from the calendar graphic.
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License agreement documents
Universal Type Server can store digital copies of important documents related to your font license.

n To add a document to the list of License Agreement Documents, click the + button, enter a name
for the document, browse for a file to upload or enter an URL to the document, then click the Save
button.

n To remove a document from the list, select it in the list and click the - button.
n To view an URL or download a copy of an attached document, select it in the list and click the

View/Download button.

Applying and removing licenses
To apply licenses to fonts, chooseWindow > Fonts and Licenses.

To apply a license to a font:
1. Select one or more fonts in the list.
2. Check the box next to the license youwant to apply to the selected fonts.

NOTE: A checkbox that looks like this indicates that some of the selected fonts have the license
applied, and some do not.

To remove a license from a font:
1. Select one or more fonts in the list.
2. Clear the checkbox next to the license youwant to remove.

Finding unlicensed fonts
There are several ways you can identify fonts that do not have licenses assigned.

n In the Fonts and Licenses window, choose Filter By > Compliance Status and click Not
Licensed.

n In the Fonts and Licenses window, choose Filter By > All Fonts, then select individual fonts to
inspect the licenses assigned to them.

n In the Reports window:
a. Click + to create a new report.
b. Choose Report Type > Font Usage
c. Choose Filter By > All Fonts
d. Click theGenerate Report button.
e. Select the generated report in the list at the left.
f. In the Report Data pane, click the License column to sort the data by font license.

Unlicensed fonts are shown with a license “0” (zero).
g. Use one of the Export buttons to export the data.

n In the Universal Type Client, you can create a Smart Set to show unlicensed fonts in any
workgroup. See the Type Client User Guide or help system for details.
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Reports
The User Management application offers access to a variety of reports that provide details about your
system, fonts, users, and font usage.

Using reports
n You can filter a data list to only display entries that contain certain text. Type some text in the

field at the bottom right of the window and press RETURN or ENTER; the data list will be updated
to show only those entries where the text you typed appears in any column (except the Account
Type column, for reports that display this).

n Click a column head in a data list to sort the list on that columns; click again to reverse the sort
order.

n To resize a column, drag the right side of the column’s head.
n Click one of the Export buttons at the bottom right of the screen to export the report data to use

in other applications.

NOTE: If all of the individual reports are blank, there is probably a port conflict on your Universal Type
Server. Alert your server administrator.
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REPORT PURPOSE SEARCHING AND SORTING DATA DETAILS

Fonts by Name The list shows all fonts available to your Type
Server so that you can see all fonts quickly.

Search and sort by PostScript Name, Foundry,
Version, and Font Type.

The interactive pie chart offers one-click
filtering to view fonts by Font Type.

This report displays all fonts served by your
Type Server as of the time that you generate
the report.

Fonts by License The list shows fonts assigned to licenses so that
you can track how fonts are being licensed in
your organization.

Search and sort on Postscript Name, Foundry,
Version, and Font Type.

The interactive bar chart offers one-click
filtering to see the fonts assigned to a
particular license.

This report shows all fonts and licenses in your
Type Server as of the time that you generate
the report.

NOTE: A font may be assigned to multiple
licenses.

Fonts by Workgroup The list shows fonts assigned to each
workgroup so you can easily see how many
fonts there are in each workgroup, and which
ones they are.

Search and sort by PostScript Name, Foundry,
Version, and Font Type.

The interactive bar chart offers one-click
filtering to view in each workgroup.

This report displays all fonts and workgroups in
your Type Server as of the time that you
generate the report.

Duplicates The list shows fonts that have multiple copies
or versions stored on the Type Server so that
you can remove unwanted versions.

Search and sort by PostScript Name and
Number of Occurrences.

Click the icon at the left of an entry to
display more information about the duplicate
fonts.

See Additional report information on
page 60.

Users by Name The list shows all users and their account
details so that you can ensure that all font
users are able to connect to Universal Type
Server.

Search and sort on name, date added and
account type.

This report displays all user accounts in your
Type Server as of the time that you generate
the report.

Users by Workgroup The list shows user accounts for each
workgroup so you can easily see how many
users there are in each workgroup and who
they are.

Search and sort on account name, full name,
and account type.

The interactive bar chart offers one-click
filtering to view users in each workgroup.

This report displays all users and workgroups in
your Type Server as of the time that you
generate the report.

Settings The list shows user accounts and their settings
so that you can monitor user settings across
your entire font environment.

Search and sort on account name, full name,
Client Replication Mode, Synchronization
Interval, System Font Policy status, and
Personal Workgroup setting.

This report displays settings for all users in your
Type Server as of the time that you generate
the report.

See Settings on page 36 for details about the
available settings and possible values.

Out of Compliance The list shows which fonts have been out of
compliance by how many “seats” over the
available license count within the past 90 days
so that you can maintain the necessary
number of licenses at all times.

Search and sort on Postscript Name, Version,
Font Type, Font ID, License Count, and License
Usage.

This report shows data accumulated over the
previous 90 days.

See Additional report information on page 60
for more information about compliance
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REPORT PURPOSE SEARCHING AND SORTING DATA DETAILS

Font Usage by User The list shows fonts used by the selected user in
all of their workgroups.

Search and sort on Font Name, Postscript
Name, Family, Foundry, Version, and Font
Sense ID.

This report provides a current font usage
snapshot as of the time that you generate the
report.

Font Usage by Workgroup The list shows fonts in all workgroups or a
selected workgroup, with out-of-compliance
fonts emphasized to provide an at-a-glance
usage report that will help you keep your fonts
in compliance and ensure that your users do
not overuse their allocated licenses.

Search and sort on Font Name, Postscript
Name, Family, Foundry, Version, and License.
The interactive bar chart offers one-click
filtering to see the fonts assigned to a shared
set in the selected workgroup.

This report provides a current font usage
snapshot as of the time that you generate the
report.

Client Connections The list shows current connections for the
selected account type so you can monitor user
activity and client currency.

Search and sort on account name, full name,
IP address, Machine ID, Login Date, and Active
status.

The interactive pie chart offers one-click
filtering to view client connections by account
type.

This report displays all clients connected to the
Type Server as of the time that you generate
the report.
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Additional report information
Out of Compliance report
Compliance is determined by font usage based on the licenses that you create and assign in the User
Management application.

When a font is considered “in use” depends on the type of client replication being used:
n On Demand: Connected clients tell the Type Server when a font is activated or deactivated.
n On Demand with Cache: Connected clients tell the Type Server when a font is activated or

deactivated. Fonts are cached, so activation may occur faster than on a non-cached client
(which may have to download the font again).

n All: The client tells the server that all fonts are in use, assuming them to be active or able to be
activated if the system goes offline.

n GoOffline: Similar to the All mode; if the user does not wait for fonts to synch after invoking the
“GoOffline” command, only those fonts that have been downloaded will be considered “in use.”

Each font license includes a list of licensed fonts and the number of “seats” that can actively use the
font simultaneously.

A font is in compliance if the number of seats where the font is “in use” does not exceed the total number
of seats licensed for that font.

A font goes out of compliance if it is in use at more seats than the total number of licensed seats.

The Out of Compliance report shows fonts that have been out of compliance at some point in the past 90
days. It’s important to understand that fonts listed in this report may not be out of compliance at the
time that you generate the report.

Use the compliance report to determine if you need to acquire more licenses for a font that is routinely
out of compliance.

NOTE: A font can only go out of compliance if one or more of the licenses that include it has its
Enforcement mode set toNotify only. Strict enforced licenses will not go out of compliance, but you
may have content creators unable to work because they are denied access to fonts that are in use by
the maximum number of allowed seats.

See Font licenses on page 54 for details about creating and assigning fonts to licenses.

Duplicate Fonts report
Duplicate fonts will typically have the same PostScript name and Display name, but different versions
and/or foundries, and different Font Sense IDs.

Depending on your workflow, it may be important to keep these different versions available; subtle
differences in glyph shape, kerning, and other elements may be important tomaintaining the look of a
specific client’s documents.
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Contacting Extensis
Extensis
1800 SW First Avenue, Suite 500
Portland, OR 97201
Web: https://www.extensis.com/

Extensis Europe
Suites 17 & 18, Newton House
Kings Park Road, Moulton Park
Northampton NN3 6LG, United Kingdom

Customer Support
Support Form: https://help.extensis.com/hc/en-us/requests/new/

Sales
Web: https://www.extensis.com/contact-us-form/ (all regions)
We also work with resellers around the world; find one near you.

Extensis: https://www.extensis.com/
Support Form: https://help.extensis.com/hc/en-us/requests/new/
Sales: https://www.extensis.com/contact-us-form/
Extensis Channel Partners: https://www.extensis.com/resellers/

https://www.extensis.com/
https://help.extensis.com/hc/en-us/requests/new/
https://www.extensis.com/contact-us-form/
https://www.extensis.com/resellers/
https://www.extensis.com/
https://help.extensis.com/hc/en-us/requests/new/
https://www.extensis.com/contact-us-form/
https://www.extensis.com/resellers/
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Support
Use these resources to get answers to questions you have about Universal Type Server and other Extensis
products.

Universal Type Server
Universal Type Server Support
This page links to installers, PDF downloads, and other common support resources.

Universal Type Server System Requirements
Full system requirements and other information about the current version of Universal Type Server.

Universal Type Server Release Notes
Historical release notes for all updates to the current major release of Universal Type Server.

Universal Type Server Knowledge Base
Articles describing situational issues and solutions to user-reported problems with Universal Type Server.

Universal Type Server Videos
Get hands-on help through short video tutorials (in English).

Universal Type Server: Compatibility Guide
This page provides details on the support status of Universal Type Server with recent operating systems
and databases.

Universal Type Client: Compatibility Guide
Shows compatibility between recent Type Client versions, operating systems, and third-party
applications.

Universal Type Server Support: https://www.extensis.com/support/universal-type-server-7
Universal Type Server System Requirements: https://www.extensis.com/support/universal-type-server-

7/system-requirements
Universal Type Server Release Notes: https://www.extensis.com/support/universal-type-server-7/release-

notes
Universal Type Server Knowledge Base: https://help.extensis.com/hc/en-us/categories/360000852313
Universal Type Server Videos: https://help.extensis.com/hc/en-us/sections/360002626213
Universal Type Server: Compatibility Guide: https://www.extensis.com/support/universal-type-server-

support-guide/
Universal Type Client: Compatibility Guide: https://www.extensis.com/support/universal-type-client-

support-guide/

https://www.extensis.com/support/universal-type-server-7
https://www.extensis.com/support/universal-type-server-7/system-requirements
https://www.extensis.com/support/universal-type-server-7/release-notes
https://help.extensis.com/hc/en-us/categories/360000852313
https://help.extensis.com/hc/en-us/sections/360002626213
https://www.extensis.com/support/universal-type-server-support-guide/
https://www.extensis.com/support/universal-type-client-support-guide/
https://www.extensis.com/support/universal-type-server-7
https://www.extensis.com/support/universal-type-server-7/system-requirements
https://www.extensis.com/support/universal-type-server-7/system-requirements
https://www.extensis.com/support/universal-type-server-7/release-notes
https://www.extensis.com/support/universal-type-server-7/release-notes
https://help.extensis.com/hc/en-us/categories/360000852313
https://help.extensis.com/hc/en-us/sections/360002626213
https://www.extensis.com/support/universal-type-server-support-guide/
https://www.extensis.com/support/universal-type-server-support-guide/
https://www.extensis.com/support/universal-type-client-support-guide/
https://www.extensis.com/support/universal-type-client-support-guide/
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General resources
Extensis Knowledge Base
Search for articles about any current Extensis product, and retired versions as well.

Support Services
Details about types of support and hours of availability, including our Support Policy.

Our Support Policy in a nutshell
Extensis provides full support for the current version of all shipping products. In addition, Extensis
provides limited support for older products up to one year after the product version is no longer offered
for sale.

Extensis’s Videos on Vimeo
Hundreds of training sessions, events, and webinars. These are mostly in English, but there are some
gems in French and German as well.

Extensis Videos on YouTube
Training, event, and educational videos.

Support Form
Use this form to submit a support case.

Provide as much of the following information as you can:
n Your email address;
n As the Subject, a brief description of the problem you are having;
n A more detailed description of the problem: when it occurs, whether you can reproduce it,

whether it has caused you to lose data, and any other details to help our staff track down the
issue.

n Your company name or account number;
n The type of support you need (generally you’ll choose Fix an Issue/Technical Support);
n The product you’re using;
n The version of the product (generally this is in the product’s About box);
n Your operating system;
n Any creative application that might also be affected.

You can also attach a screen shot or other file related to your issue.

Chat

Click at the bottom right of any page of the Extensis website. (Chat is only available between
8:00AM and 3:00PM Pacific time, Monday through Friday.)

Learn and Support
Links to white papers, testimonials, blog posts, and other resources.

Extensis Knowledge Base: https://help.extensis.com/hc/en-us/
Support Services: https://www.extensis.com/support/support-policy/
Extensis’s Videos on Vimeo: https://vimeo.com/extensis/videos/
Extensis Videos on YouTube: https://www.youtube.com/user/extensisblog
Support Form: https://help.extensis.com/hc/en-us/requests/new/
Chat: https://www.extensis.com
Learn and Support: https://www.extensis.com/learn-and-support/

https://help.extensis.com/hc/en-us/
https://www.extensis.com/support/support-policy/
https://vimeo.com/extensis/videos/
https://www.youtube.com/user/extensisblog
https://help.extensis.com/hc/en-us/requests/new/
https://www.extensis.com/
https://www.extensis.com/learn-and-support/
https://help.extensis.com/hc/en-us/
https://www.extensis.com/support/support-policy/
https://vimeo.com/extensis/videos/
https://www.youtube.com/user/extensisblog
https://help.extensis.com/hc/en-us/requests/new/
https://www.extensis.com/
https://www.extensis.com/learn-and-support/
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Legal resources
Extensis EULA (on page 65)
The legalese description of your rights while using Universal Type Server and any associated services.

Privacy Policy
Details about information we collect and how we use it, including information specific to Europe and
California.

Privacy Shield Policy
Details about our practices regarding personal information transmitted to us from organizations subject
to protection laws in the European Economic Area and Switzerland.

Terms of Use
These terms apply to everything you do on our websites and affiliated websites. They are not the same
as terms detailed in the Extensis EULA, which apply specifically to software and related services.

Privacy Policy: https://www.extensis.com/privacy-policy/
Privacy Shield Policy: https://www.extensis.com/privacy-shield-policy/
Terms of Use: https://www.extensis.com/terms-of-use/

https://www.extensis.com/privacy-policy/
https://www.extensis.com/privacy-shield-policy/
https://www.extensis.com/terms-of-use/
https://www.extensis.com/privacy-policy/
https://www.extensis.com/privacy-shield-policy/
https://www.extensis.com/terms-of-use/
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Extensis EULA
CELARTEM, INC., doing business as Extensis
1800 SW FIRST AVENUE, SUITE 500
PORTLAND, OR 97201
(503) 274-2020 Phone
(503) 274-0530 Fax
https://www.extensis.com/

SOFTWARE LICENSE AGREEMENT
IMPORTANT—READ CAREFULLY. This Software License Agreement (Agreement) is a legal agreement between you
(either as an individual or a single entity) and Celartem, Inc., doing business as Extensis (“Extensis”), for Extensis’
software products, which includes the server and client software, failover software (if licensed), associated media,
printed materials, online or electronic documentation, and any subsequent updates, upgrades, bug fixes, or patches
provided by Extensis (collectively “Software”), and for any related services which may be provided by Extensis. By
installing, copying or using the Software you agree to be bound by the terms and conditions of this Agreement.

1. Definitions. For the purposes of this Agreement, the following capitalized words and phrases shall be ascribed the
following meanings:

1.1 “Authorized Server” means a computer workstation or server designated to run the Server Software for use by your
Authorized Concurrent Users and administrators of such Authorized Server. Unless you have purchased a multi-server
production license for the Software, youmay only install the Server Software on one Authorized Server for your
production purposes. Youmay make additional copies of the Software to install on a development and/or test server for
each production license of the Software that you have purchased, provided (i) all copyright, patent, trade secret,
trademark or other proprietary right or disclaimer appearing in or on the Software or any accompanying materials
(collectively “Ownership Notices”) are reproduced on each Software copy; and (ii) such Software copies are not
concurrently used for production purposes.

1.2 “Authorized Concurrent Users” means you and/or your employees or independent contractors that you authorize to
have concurrent access to and use of the Server Software pursuant to the terms of this Agreement. Your permitted
number of Authorized Concurrent Users is determined by the number of Authorized Concurrent User licenses purchased
by you under this Agreement for the applicable Server Software.

1.3 “Client Software” means that portion of the Software that is designated in its documentation for use on a
workstation that may be connected to your Authorized Server(s) when the Server Software is being used.

1.4 “Failover Software” means that portion of the Software that is designated for use on a separate server solely for
failover purposes.

1.5 “Serial Number” means a character scheme identified as the Serial Number for the Server Software and Failover
Software provided to you by Extensis.

1.6 “Server Software” means that portion of the Software that is designated in its documentation for installation and use
on your Authorized Server(s).

1.7 “Software” means the Client, Server, Failover, Module and Connector Software which may be licensed to you under
this Agreement. The Third Party Software described below are not included in the definition of “Software”.

1.8 “Software License Term” means the term of your Software license that you have purchased under this Agreement.
Your Software License Term is more fully described in Section 7 Term and Termination below.

1.9 “Third Party Software” means third party software such as software applications or components owned and licensed
by third party licensors. Third Party Software are subject to the terms set forth below.

(a) “Third Party Software Components” means Third Party Software such as libraries or other components (including
open source) that are integrated by Extensis into the Software, or are required by Extensis for use of the Software. Third
Party Software Components are subject to their respective licensors’ applicable terms and conditions which are
contained in Extensis’ or its licensor’s online electronic documentation accompanying the Third Party Software
Components. Your use of the Third Party Software Components shall be governed solely by the applicable Third Party
Software Components terms and conditions.

https://www.extensis.com/
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(b) “Third Party Software Applications” means Third Party Software that you license from the licensor and install and
maintain on your server(s). Third Party Software Applications are standalone products from the Software and any Third
Party Software Components as defined above. Third Party Software Applications are subject solely to the applicable
licensors’ terms and conditions between you and such licensor, and Extensis shall have no responsibility for such Third
Party Software Applications.

1.10 “Authorized Third Party Software Application Instances” means the number of instances that Extensis licenses to
you to connect your Third Party Software Applications to the Software.

1.11 “Module Software” means a Software component Extensis licenses to you that enables a connection between the
Server Software and your Connector Software.

1.12 “Connector Software” means a Software component Extensis licenses to you that enables a connection between the
Module Software and your Third Party Software Applications.

2. Software Licenses.

2.1 Client, Server, Failover, Module and Connector Software Licenses. During your Software License Term, Extensis
grants to you, as applicable:

(a) Server Software License. Extensis grants to you a non-exclusive, non-transferable license to install and use the Server
Software on your Authorized Server(s) and allow your permitted number of Authorized Concurrent Users to use the Server
Software.

(b) Client Software License. Extensis grants to you a non-exclusive, non-transferable license to reproduce, distribute and
install your authorized number of copies of the Client Software on the workstations or individual computers of the
Authorized Concurrent Users.

(c) Module Software License. Extensis grants to you a non-exclusive, non-transferable license to reproduce, distribute
and install your authorized number of copies of the Module Software on the workstations or individual computers of the
Authorized Concurrent Users as needed to connect to your Connector Software.

(d) Connector Software License. Extensis grants to you a non-exclusive, non-transferable license to reproduce, distribute
and install your authorized number of copies of the Connector Software on the workstations or individual computers of
the Authorized Concurrent Users as needed to connect to your Authorized Third Party Software Applications, up to your
permitted number of Authorized Third Party Software Application Instances or Nodes.

2.2 All right, title to and ownership of all applicable intellectual property rights in the Software, including but not limited
to patents, copyrights and trade secrets remain with Extensis and its licensors. Software is unpublished software, trade
secret and confidential or proprietary information of Extensis or its licensors and is commercial software developed at
private expense. The Software is comprised of “commercial items”, “commercial computer software” and “commercial
computer software documentation” as defined in FAR 2.101, DFAR 252.227-7014(a)(1) and DFAR 252.227-7014(a)(5).
Consistent with DFAR 227.7202 and FAR 12.212, any use, reproduction, display, or disclosure by the USGovernment
shall be governed solely by the terms of this Agreement.

2.3 Youmay not transfer the Software and/or any accompanying materials without the prior written consent of
Extensis, such consent not to be unreasonably withheld. Any attempted transfer without Extensis’ prior written consent,
including any transfer out of the country where the Software license was originally purchased, shall be null and void and
of no force or effect.

2.4 If you are licensed to use the Failover Software, youmay use the Failover Software on a separate server solely for
failover purposes. The Failover Software may not be used in conjunction with the Server Software on the Authorized
Server, and may only be accessed and used by your designated administrators of the designated failover server.

2.5 All rights not expressly granted hereunder are reserved by Extensis.

3. Software Access and Extensis Account. Use of the Software requires an Internet connection to activate your
Software license at time of installation and to activate additional or updated Software licenses. Use of the Software will
also require you to obtain and maintain an Extensis account (“Extensis Account”).

In addition, the Software will automatically connect to the Internet to provide youwith additional Software information
or to notify Extensis of the results of your Software activation attempts. Youmay also receive information from Extensis
related to your Software license or Extensis Account.

4. Software License Restrictions and Obligations.
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4.1 You cannot reverse engineer, decompile or disassemble the Software, in whole or in part, except and only to the
extent that such activity is expressly permitted by applicable law. Youmay not remove, obscure or alter any Ownership
Notices appearing in or on the Software or any accompanying materials. In addition to your limited right to copy as set
forth in Section 1.1 above, youmay reproduce the Software only as reasonably necessary for your own internal disaster
recovery, backup or archival purposes only provided you retain all Ownership Notices in such copies. Youmay allow up to
the permitted number of Authorized Concurrent Users the right to copy and use the Software’s accompanying
documentation in conjunction with their use of the Software provided all Ownership Notices are retained in such copies
of the documentation. Youmay not disclose to any non-licensed concurrent user or third party nor allow any non-
licensed concurrent user or third party to have access to or use of the Software or your assigned Serial Number. Youmay
not use the Software in time sharing, hosted or subscription services, or any other manner which allows a third party to
use the Software without obtaining an authorized license from Extensis. Youmay not use, copy, modify, lend, lease, rent,
disclose, distribute, sell, license, sublicense or otherwise transfer the Software or any copies thereof, in whole or in part,
except as expressly provided in this Agreement.

4.2 Extensis reserves the right, with or without notice, to restrict your use or access to the Software, in whole or in part, if
Extensis reasonably determines that there is an unauthorized use of the Software, your assigned Serial Number, or use or
access to the Software by persons or entities who are not Authorized Concurrent Users. Such restriction by Extensis shall
not be a breach of this Agreement by Extensis, and shall be in addition to any other rights and remedies Extensis has
under law and equity.

5. DISCLAIMER OF WARRANTY. THE SOFTWARE AND ANY RELATED SERVICES PROVIDED BY EXTENSIS ARE PROVIDED
“AS IS”. EXTENSIS DISCLAIMS ALL WARRANTIESON THE SOFTWARE AND RELATED SERVICES, EITHER EXPRESSOR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIEDWARRANTYOF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, OR FOR ANY IMPLIEDWARRANTY ARISING FROM COURSE OF PERFORMANCE, COURSE OF
DEALING, USAGEOR TRADE, OR NONINFRINGEMENT. EXTENSIS DOES NOT REPRESENT ORWARRANT THAT THE
SOFTWAREOR RELATED SERVICESWILL ACHIEVE ANY SPECIFIC RESULT OR REQUIREMENT IN YOUR BUSINESS, OPERATE
WITHOUT INTERRUPTION, OR BE ERROR-FREE IN OPERATION. YOUR STATE MAY PROVIDE YOUWITH SPECIFIC LEGAL
RIGHTSWITH RESPECT TO SOFTWAREWARRANTIES; SUCH RIGHTS VARY FROM STATE TO STATE.

6. LIMITATION OF LIABILITY. IN NO EVENT SHALL EXTENSIS BE LIABLE FOR ANY DAMAGES, INCLUDING ANY THIRD PARTY
DAMAGESOR CLAIMS, RESULTING FROM LOSSOF DATA, USE, PROFIT OR REVENUE, OR FOR ANY INDIRECT, SPECIAL,
CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED, EVEN IF EXTENSIS HAS BEEN ADVISEDOF THE
POSSIBILITY OF SUCH DAMAGES. EXTENSIS’ AGGREGATE LIABILITY FOR ANYOTHER DAMAGES SHALL IN NO EVENT
EXCEED: (A) WITH RESPECT TO A PERPETUAL SOFTWARE LICENSE, THE AMOUNT YOU PAID FOR THE SOFTWARE AND/OR
RELATED SERVICES THAT CAUSED SUCH DAMAGES; OR (B) WITH RESPECT TO A SOFTWARE LICENSE SUBSCRIPTION, THE
AMOUNT PAID FOR THE SOFTWARE AND/OR RELATED SERVICES DURING THE PRECEDING TWELVE (12) MONTH PERIOD
FROMWHEN THE CAUSE OF ACTION AROSE. THIS LIMITATION OF EXTENSIS’ LIABILITY FOR SOFTWARE AND ANY RELATED
SERVICESWILL APPLY REGARDLESSOF THE FORM OF ACTION, WHETHER IN CONTRACT OR IN TORT INCLUDING
NEGLIGENCEOR ANYOTHER BASIS. BECAUSE YOUR STATE MAY NOT ALLOW THE ABOVE EXCLUSIONSOR LIMITATIONS
OF LIABILITY, THE ABOVE LIMITATIONSMAY NOT APPLY TO YOU.

7. Term and Termination. The Term of this Agreement shall commence upon the date you first install, copy or use the
Software.

7.1 If you purchased a perpetual Software license, then your Software License Term will continue indefinitely under this
Agreement unless terminated as set forth in Section 7.2 below, or when you discontinue use of the Software. If you are
licensed under a Software license subscription, then your Software License Term will be the applicable time period
purchased by you for your Software license subscription. Your Software license subscription will automatically renew at
Extensis’ then current rates unless either party provides the other party with written notice at least sixty (60) days prior
to the expiration of the then current subscription term, of its intention not to renew the Software license subscription.
Upon such proper notification to the other party, the Software license subscription will terminate at the end of such then
current term. For purposes of clarity, Software license subscriptions are non-cancelable.

7.2 Extensis may immediately terminate this Agreement if you are in default of any provision of this Agreement. In the
event of such termination, youmust either return or destroy the Software and all copies thereof, in whole or in part, and
provide Extensis with written certification of such return or destruction.

8. Consent to Use of Data
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8.1 Customer Data. Extensis collects and uses technical data and related information, including but not limited to
technical information about our customers’ devices, systems and application software, peripherals and computer
configurations used in connection with the Software so that we can improve and facilitate the provision of Software
updates, technical and product support, security measures and other services to our customers. Extensis will use this
information in an anonymized and aggregated form that will not personally identify you.

8.2 Your Data. As permitted by applicable law or per your consent, Extensis may also collect and use information
provided by you under your Extensis Account, and/or certain information related to your use of the Software and/or your
Extensis Account such as your Extensis Account number, user behavior, number of current sessions, number of seats,
number of fonts, workgroups, roles, product information and other data items. Extensis may also send, via email, phone
calls, direct in-application messaging, or some other method of communication: (a) transactional messages to facilitate
the use of the Software; or (b) marketing to provide information about the Software and other Extensis products and
Services using information including but not limited to platform version, version of the Software, license status, and
language.

8.3 Access to and use of the Software and the Extensis Account, and Extensis’ right to collect and use the data described
above (and your right to opt out) shall be in accordance with this Agreement and the following terms current at the time
of access:

Extensis’ terms of use at https://www.extensis.com/terms-of-use/ (“Terms of Use”).
Extensis’ privacy policy at https://www.extensis.com/privacy-policy/ (“Privacy Policy”).
Extensis’ privacy shield policy at https://www.extensis.com/privacy-shield-policy/ (“Privacy Shield Policy”).
Any terms in the Software documentation and any additional terms of use that might be presented to you at the time

of your Software license activation and/or access to your Extensis Account (“Additional Terms of Use”).

Extensis reserves the right to, from time to time, in its sole discretion to update or modify the Terms of Use, Privacy Policy,
Privacy Shield Policy and any Additional Terms of Use and such changes will take effect when posted by Extensis. It is
your responsibility to be aware of and abide by the most current version of the Terms of Use, Privacy Policy, Privacy
Shield Policy and any Additional Terms of Use. Your continued use of the Software and your Extensis Account constitutes
your acceptance of the most current version of these terms. If you are unable to find the information you need or have
any questions with respect to our collection and use of data and/or your ability to opt out of such collection and use,
please contact us at https://help.extensis.com/hc/en-us/requests/new/.

9. Third Party Websites. Your Extensis Account may provide links to third party websites. These links are provided for
your convenience only and Extensis reserves the right to terminate any third party website link at any time for any
reason. Extensis does not control any of these third party websites, their content, terms of use, or privacy policies.
Extensis makes no endorsement, promise, representation, warranty or guarantee and shall not have any responsibility
in connection with these third party websites, including without limitation, any products or services offered through such
third party websites. If you choose to access and use such third party websites you do so entirely at your own risk. Your
access to and/or use of these third party websites and related products and services shall be governed by the third
party website’s terms and conditions, including its terms of use and privacy policy, and applicable terms and conditions
for its products and services.

10. Audit. Extensis shall have the right to inspect and audit your records pertaining to the Software to ensure ongoing
compliance with this Agreement. Extensis or Extensis’ independent certified public accountant shall conduct such
inspection and audit at Extensis’ expense. Any inspection and audit will be conducted during regular business hours with
reasonable notice and will not unreasonably interfere with your normal business activities. Inspections and audits will
not occur more frequently than once a year, however, if past inspections and audits reveal major discrepancies, Extensis
shall have the right at any time to an inspection and audit upon written request. If any inspection and audit reveals any
underreported, unpaid or unauthorized use of the Software, then you shall promptly pay to Extensis the then current fee
representing the underreported, unpaid or unauthorized use of the Software. In addition, youwill be responsible for the
costs and expenses of the inspection and audit if such inspection and audit reveals that the then current fee
representing the underreported, unpaid or unauthorized use of the Software is equal to or greater than 5% of the
amounts actually paid by you for such Software.

11. Export. Youmay not export or re-export the Software or any direct product thereof without the appropriate United
States or foreign government export licenses and approvals.

12. Force Majeure. Extensis will not be liable to you for any delay or failure by Extensis to perform its obligations under
this Agreement or otherwise if such delay or failure arises from any cause or causes beyond the reasonable control of

https://www.extensis.com/terms-of-use/
https://www.extensis.com/privacy-policy/
https://www.extensis.com/privacy-policy/
https://help.extensis.com/hc/en-us/requests/new/
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Extensis, including, but not limited to, labor disputes, strikes, other lab or industrial disturbances, acts of God, floods,
lightning, shortages of materials, rationing, utility or communications failures, earthquakes, casualty, war, acts of the
public enemy, riots, insurrections, embargoes, blockages, actions, restrictions, regulations or orders of any government,
agency or subdivisions thereof.

13. Invalid Provision. The invalidity or unenforceability of any provision of this Agreement shall not affect the other
provisions hereof, and this Agreement shall be construed in all respects as if such invalid or unenforceable provisions
were omitted.

14. Governing Law. This Agreement shall be governed by the laws of the State of Oregon, excluding that body of law
known as conflicts of laws, and the United Nations Convention on Contracts for the International Sale of Goods.

15. Entire Agreement. This Agreement constitutes the entire agreement between the parties and supersedes all prior or
contemporaneous written, electronic or oral communications, representations, agreements or understandings between
the parties with respect to the subject matter hereto.

June 2020
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